SAFETY PRECAUTIONS

(Read these precautions before using this product.)
Before using this product, please read this manual and the relevant manuals carefully and pay full attention to safety to handle the product correctly.

The precautions given in this manual are concerned with this product only. For the safety precautions of the programmable controller system, refer to MELSEC iQ-R Module Configuration Manual.
In this manual, the safety precautions are classified into two levels: "⚠️ WARNING" and "⚠️ CAUTION".

⚠️ WARNING Indicates that incorrect handling may cause hazardous conditions, resulting in death or severe injury.

⚠️ CAUTION Indicates that incorrect handling may cause hazardous conditions, resulting in minor or moderate injury or property damage.

Under some circumstances, failure to observe the precautions given under "⚠️ CAUTION" may lead to serious consequences.
Observe the precautions of both levels because they are important for personal and system safety.
Make sure that the end users read this manual and then keep the manual in a safe place for future reference.

[Considerations for using this manual]

- Replace the terms used in the following pages in this manual with the terms shown on the right, respectively.

  Corresponding page: SAFETY PRECAUTIONS, CONDITIONS OF USE FOR THE PRODUCT, and COMPLIANCE WITH EMC AND LOW VOLTAGE DIRECTIVES

  (1) "Programmable controller" → "C Controller module"

  (2) "Programmable controller system" → "C Controller system"

- For details on a fail-safe circuit for a C Controller system, refer to the following manual.

  MELSEC iQ-R C Controller Module User's Manual (Application)
[Design Precautions]

⚠️ **WARNING**

- Configure safety circuits external to the programmable controller to ensure that the entire system operates safely even when a fault occurs in the external power supply or the programmable controller. Failure to do so may result in an accident due to an incorrect output or malfunction.

1. Emergency stop circuits, protection circuits, and protective interlock circuits for conflicting operations (such as forward/reverse rotations or upper/lower limit positioning) must be configured external to the programmable controller.

2. When the programmable controller detects an abnormal condition, it stops the operation and all outputs are:
   - Turned off if the overcurrent or overvoltage protection of the power supply module is activated.
   - Held or turned off according to the parameter setting if the self-diagnostic function of the CPU module detects an error such as a watchdog timer error.

3. All outputs may be turned on if an error occurs in a part, such as an I/O control part, where the CPU module cannot detect any error. To ensure safety operation in such a case, provide a safety mechanism or a fail-safe circuit external to the programmable controller. For a fail-safe circuit example, refer to "General Safety Requirements" in MELSEC iQ-R Module Configuration Manual.

4. Outputs may remain on or off due to a failure of a component such as a relay and transistor in an output circuit. Configure an external circuit for monitoring output signals that could cause a serious accident.

- In an output circuit, when a load current exceeding the rated current or an overcurrent caused by a load short-circuit flows for a long time, it may cause smoke and fire. To prevent this, configure an external safety circuit, such as a fuse.

- Configure a circuit so that the programmable controller is turned on first and then the external power supply. If the external power supply is turned on first, an accident may occur due to an incorrect output or malfunction.

- Configure a circuit so that the external power supply is turned off first and then the programmable controller. If the programmable controller is turned off first, an accident may occur due to an incorrect output or malfunction.

- For the operating status of each station after a communication failure, refer to manuals for the network used. For the manuals, please consult your local Mitsubishi representative. Incorrect output or malfunction due to a communication failure may result in an accident.

- When connecting an external device with a CPU module or intelligent function module to modify data of a running programmable controller, configure an interlock circuit in the program to ensure that the entire system will always operate safely. For other forms of control (such as program modification, parameter change, forced output, or operating status change) of a running programmable controller, read the relevant manuals carefully and ensure that the operation is safe before proceeding. Improper operation may damage machines or cause accidents. When a Safety CPU is used, data cannot be modified while the Safety CPU is in SAFETY MODE.

- Especially, when a remote programmable controller is controlled by an external device, immediate action cannot be taken if a problem occurs in the programmable controller due to a communication failure. To prevent this, configure an interlock circuit in the program, and determine corrective actions to be taken between the external device and CPU module in case of a communication failure.
[Design Precautions]

**WARNING**

- Do not write any data to the "system area" and "write-protect area" of the buffer memory in the module. Also, do not use any "use prohibited" signals as an output signal from the CPU module to each module. Doing so may cause malfunction of the programmable controller system. For the "system area", "write-protect area", and the "use prohibited" signals, refer to the user's manual for the module used. For areas used for safety communications, they are protected from being written by users, and thus safety communications failure caused by data writing does not occur.

- If a communication cable is disconnected, the network may be unstable, resulting in a communication failure of multiple stations. Configure an interlock circuit in the program to ensure that the entire system will always operate safely even if communications fail. Incorrect output or malfunction due to a communication failure may result in an accident. When safety communications are used, an interlock by the safety station interlock function protects the system from an incorrect output or malfunction.

[Precautions for using C Controller modules]

- In the settings of refresh parameters, link output (LY) refresh devices and remote output (RY) refresh devices do not allow the specification of Y. Thus, the CPU module holds the device status even after its status is changed to STOP.

[Design Precautions]

**CAUTION**

- Do not install the control lines or communication cables together with the main circuit lines or power cables. Doing so may result in malfunction due to electromagnetic interference. Keep a distance of 100mm or more between those cables.

- During control of an inductive load such as a lamp, heater, or solenoid valve, a large current (approximately ten times greater than normal) may flow when the output is turned from off to on. Therefore, use a module that has a sufficient current rating.

- After the CPU module is powered on or is reset, the time taken to enter the RUN status varies depending on the system configuration, parameter settings, and/or program size. Design circuits so that the entire system will always operate safely, regardless of the time.

- Do not power off the programmable controller or reset the CPU module while the settings are being written. Doing so will make the data in the flash ROM and SD memory card undefined. The values need to be set in the buffer memory and written to the flash ROM and SD memory card again. Doing so also may cause malfunction or failure of the module.

- When changing the operating status of the CPU module from external devices (such as the remote RUN/STOP functions), select "Do Not Open by Program" for "Opening Method" of "Module Parameter". If "Open by Program" is selected, an execution of the remote STOP function causes the communication line to close. Consequently, the CPU module cannot reopen the line, and external devices cannot execute the remote RUN function.
[Security Precautions]

⚠️ WARNING

● To maintain the security (confidentiality, integrity, and availability) of the programmable controller and the system against unauthorized access, denial-of-service (DoS) attacks, computer viruses, and other cyberattacks from external devices via the network, take appropriate measures such as firewalls, virtual private networks (VPNs), and antivirus solutions.

[Installation Precautions]

⚠️ WARNING

● Shut off the external power supply (all phases) used in the system before mounting or removing the module. Failure to do so may result in electric shock or cause the module to fail or malfunction.

[Precautions for using C Controller modules]

● When mounting a C Controller module, make sure to attach the included connector cover for a base unit to the module connector of the second slot to prevent entrance of foreign material such as dust.
[Installation Precautions]

⚠️ CAUTION ⚠️

● Use the programmable controller in an environment that meets the general specifications in the Safety Guidelines (IB-0800525). Failure to do so may result in electric shock, fire, malfunction, or damage to or deterioration of the product.
● To mount a module, place the concave part(s) located at the bottom onto the guide(s) of the base unit, and push in the module until the hook(s) located at the top snaps into place. Incorrect interconnection may cause malfunction, failure, or drop of the module.
● To mount a module with no module fixing hook, place the concave part(s) located at the bottom onto the guide(s) of the base unit, push in the module, and fix it with screw(s). Incorrect interconnection may cause malfunction, failure, or drop of the module.
● When using the programmable controller in an environment of frequent vibrations, fix the module with a screw.
● Tighten the screws within the specified torque range. Undertightening can cause drop of the component or wire, short circuit, or malfunction. Overtightening can damage the screw and/or module, resulting in drop, short circuit, or malfunction. For the specified torque range, refer to MELSEC iQ-R Module Configuration Manual.
● When using an extension cable, connect it to the extension cable connector of the base unit securely. Check the connection for looseness. Poor contact may cause malfunction.
● When using an SD memory card, fully insert it into the SD memory card slot. Check that it is inserted completely. Poor contact may cause malfunction.
● Securely insert an extended SRAM cassette or a battery-less option cassette into the cassette connector of the CPU module. After insertion, close the cassette cover and check that the cassette is inserted completely. Poor contact may cause malfunction.
● Beware that the module could be very hot while power is on and immediately after power-off.
● Do not directly touch any conductive parts and electronic components of the module, SD memory card, extended SRAM cassette, battery-less option cassette, or connector. Doing so can cause malfunction or failure of the module.

[Wiring Precautions]

⚠️ WARNING ⚠️

● Shut off the external power supply (all phases) used in the system before installation and wiring. Failure to do so may result in electric shock or cause the module to fail or malfunction.
● After installation and wiring, attach a blank cover module (RG60) to each empty slot before powering on the system for operation. Also, attach an extension connector protective cover*1 to each unused extension cable connector as necessary. Directly touching any conductive parts of the connectors while power is on may result in electric shock.

*1 For details, please consult your local Mitsubishi Electric representative.
[Wiring Precautions]

⚠️ CAUTION ⚠️

- Individually ground the FG and LG terminals of the programmable controller with a ground resistance of 100 ohms or less. Failure to do so may result in electric shock or malfunction.
- Use applicable solderless terminals and tighten them within the specified torque range. If any spade solderless terminal is used, it may be disconnected when the terminal screw comes loose, resulting in failure.
- Check the rated voltage and signal layout before wiring to the module, and connect the cables correctly. Connecting a power supply with a different voltage rating or incorrect wiring may cause fire or failure.
- Connectors for external devices must be crimped or pressed with the tool specified by the manufacturer, or must be correctly soldered. Incomplete connections may cause short circuit, fire, or malfunction.
- Securely connect the connector to the module. Poor contact may cause malfunction.
- Do not install the control lines or communication cables together with the main circuit lines or power cables. Doing so may result in malfunction due to noise. Keep a distance of 100mm or more between those cables.
- Place the cables in a duct or clamp them. If not, dangling cables may swing or inadvertently be pulled, resulting in malfunction or damage to modules or cables.
  In addition, the weight of the cables may put stress on modules in an environment of strong vibrations and shocks.
  Do not clamp the extension cables with the jacket stripped. Doing so may change the characteristics of the cables, resulting in malfunction.
- Check the interface type and correctly connect the cable. Incorrect wiring (connecting the cable to an incorrect interface) may cause failure of the module and external device.
- Tighten the terminal screws or connector screws within the specified torque range. Undertightening can cause drop of the screw, short circuit, fire, or malfunction. Overtightening can damage the screw and/or module, resulting in drop, short circuit, fire, or malfunction.
- When disconnecting the cable from the module, do not pull the cable by the cable part. For the cable with connector, hold the connector part of the cable. For the cable connected to the terminal block, loosen the terminal screw. Pulling the cable connected to the module may result in malfunction or damage to the module or cable.
- Prevent foreign matter such as dust or wire chips from entering the module. Such foreign matter can cause a fire, failure, or malfunction.
- When a protective film is attached to the top of the module, remove it before system operation. If not, inadequate heat dissipation of the module may cause a fire, failure, or malfunction.
- Programmable controllers must be installed in control panels. Connect the main power supply to the power supply module in the control panel through a relay terminal block. Wiring and replacement of a power supply module must be performed by qualified maintenance personnel with knowledge of protection against electric shock. For wiring, refer to MELSEC iQ-R Module Configuration Manual.
- For Ethernet cables to be used in the system, select the ones that meet the specifications in the user's manual for the module used. If not, normal data transmission is not guaranteed.
[Startup and Maintenance Precautions]

⚠️ WARNING

● Do not touch any terminal while power is on. Doing so will cause electric shock or malfunction.
● Correctly connect the battery connector. Do not charge, disassemble, heat, short-circuit, solder, or throw the battery into the fire. Also, do not expose it to liquid or strong shock. Doing so will cause the battery to produce heat, explode, ignite, or leak, resulting in injury and fire.
● Shut off the external power supply (all phases) used in the system before cleaning the module or retightening the terminal screws, connector screws, or module fixing screws. Failure to do so may result in electric shock.

[Startup and Maintenance Precautions]

⚠️ CAUTION

● When connecting an external device with a CPU module or intelligent function module to modify data of a running programmable controller, configure an interlock circuit in the program to ensure that the entire system will always operate safely. For other forms of control (such as program modification, parameter change, forced output, or operating status change) of a running programmable controller, read the relevant manuals carefully and ensure that the operation is safe before proceeding. Improper operation may damage machines or cause accidents.
● Especially, when a remote programmable controller is controlled by an external device, immediate action cannot be taken if a problem occurs in the programmable controller due to a communication failure. To prevent this, configure an interlock circuit in the program, and determine corrective actions to be taken between the external device and CPU module in case of a communication failure.
● Do not disassemble or modify the modules. Doing so may cause failure, malfunction, injury, or a fire.
● Use any radio communication device such as a cellular phone or PHS (Personal Handy-phone System) more than 25cm away in all directions from the programmable controller. Failure to do so may cause malfunction.
● Shut off the external power supply (all phases) used in the system before mounting or removing the module. Failure to do so may cause the module to fail or malfunction.
● Tighten the screws within the specified torque range. Undertightening can cause drop of the component or wire, short circuit, or malfunction. Overtightening can damage the screw and/or module, resulting in drop, short circuit, or malfunction.
● After the first use of the product, do not perform each of the following operations more than 50 times (IEC 61131-2/JIS B 3502 compliant). Exceeding the limit may cause malfunction.
  • Mounting/removing the module to/from the base unit
  • Inserting/removing the extended SRAM cassette or battery-less option cassette to/from the CPU module
  • Mounting/removing the terminal block to/from the module
  • Connecting/disconnecting the extension cable to/from the base unit
● After the first use of the product, do not insert/remove the SD memory card to/from the CPU module more than 500 times. Exceeding the limit may cause malfunction.
● Do not touch the metal terminals on the back side of the SD memory card. Doing so may cause malfunction or failure of the module.
● Do not touch the integrated circuits on the circuit board of an extended SRAM cassette or a battery-less option cassette. Doing so may cause malfunction or failure of the module.
[Startup and Maintenance Precautions]

⚠️ CAUTION
● Do not drop or apply shock to the battery to be installed in the module. Doing so may damage the battery, causing the battery fluid to leak inside the battery. If the battery is dropped or any shock is applied to it, dispose of it without using.
● Startup and maintenance of a control panel must be performed by qualified maintenance personnel with knowledge of protection against electric shock. Lock the control panel so that only qualified maintenance personnel can operate it.
● Before handling the module, touch a conducting object such as a grounded metal to discharge the static electricity from the human body. Wearing a grounded antistatic wrist strap is recommended. Failure to discharge the static electricity may cause the module to fail or malfunction.
● Use a clean and dry cloth to wipe off dirt on the module.

[Operating Precautions]

⚠️ CAUTION
● When changing data and operating status, and modifying program of the running programmable controller from an external device such as a personal computer connected to an intelligent function module, read relevant manuals carefully and ensure the safety before operation. Incorrect change or modification may cause system malfunction, damage to the machines, or accidents.
● Do not power off the programmable controller or reset the CPU module while the setting values in the buffer memory are being written to the flash ROM in the module. Doing so will make the data in the flash ROM and SD memory card undefined. The values need to be set in the buffer memory and written to the flash ROM and SD memory card again. Doing so can cause malfunction or failure of the module.

[Disposal Precautions]

⚠️ CAUTION
● When disposing of this product, treat it as industrial waste.
● When disposing of batteries, separate them from other wastes according to the local regulations. For details on battery regulations in EU member states, refer to MELSEC iQ-R Module Configuration Manual.

[Transportation Precautions]

⚠️ CAUTION
● When transporting lithium batteries, follow the transportation regulations. For details on the regulated models, refer to MELSEC iQ-R Module Configuration Manual.
● The halogens (such as fluorine, chlorine, bromine, and iodine), which are contained in a fumigant used for disinfection and pest control of wood packaging materials, may cause failure of the product. Prevent the entry of fumigant residues into the product or consider other methods (such as heat treatment) instead of fumigation. The disinfection and pest control measures must be applied to unprocessed raw wood.
CONDITIONS OF USE FOR THE PRODUCT

(1) MELSEC programmable controller ("the PRODUCT") shall be used in conditions;
   i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious accident;
   and
   ii) where the backup and fail-safe function are systematically or automatically provided outside of the PRODUCT for the
case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries.
MITSUBISHI ELECTRIC SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO
ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT
LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY the
PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY
INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI ELECTRIC USER'S, INSTRUCTION
AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT.
("Prohibited Application")

Prohibited Applications include, but not limited to, the use of the PRODUCT in;
• Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the
  public could be affected if any problem or fault occurs in the PRODUCT.
• Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality
  assurance system is required by the Purchaser or End User.
• Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator,
  Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and
  Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other
  applications where there is a significant risk of injury to the public or property.

Notwithstanding the above restrictions, Mitsubishi Electric may in its sole discretion, authorize use of the PRODUCT in
one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the specific
applications agreed to by Mitsubishi Electric and provided further that no special quality assurance or fail-safe,
redundant or other safety features which exceed the general specifications of the PRODUCTs are required. For details,
please contact the Mitsubishi Electric representative in your region.

(3) Mitsubishi Electric shall have no responsibility or liability for any problems involving programmable controller trouble and
system trouble caused by DoS attacks, unauthorized access, computer viruses, and other cyberattacks.

CONSIDERATIONS FOR USE

Considerations for the Wind River Systems product

C Controller module has an embedded real-time operating system, VxWorks, manufactured by Wind River Systems, Inc. in
the United States. We, Mitsubishi, make no warranty for the Wind River Systems product and will not be liable for any
problems and damages caused by the Wind River Systems product during use of C Controller module.
For the problems or specifications of the Wind River Systems product, refer to the corresponding manual or consult Wind
River Systems, Inc.
Contact information is available on the following website.
• Wind River Systems, Inc.: www.windriver.com
INTRODUCTION

Thank you for purchasing the Mitsubishi Electric MELSEC iQ-R series programmable controllers. This manual describes the performance specifications, procedure before operation, wiring, and communication examples to use the module listed below.

Before using this product, please read this manual and the relevant manuals carefully and develop familiarity with the functions and performance of the MELSEC iQ-R series programmable controller to handle the product correctly.

When applying the program examples provided in this manual to an actual system, ensure the applicability and confirm that it will not cause system control problems.

Please make sure that the end users read this manual.

Relevant product

R12CCPU-V

COMPLIANCE WITH EMC AND LOW VOLTAGE DIRECTIVES

Method of ensuring compliance

To ensure that Mitsubishi Electric programmable controllers maintain the EMC and Low Voltage Directives or other regulations when incorporated into other machinery or equipment, certain measures may be necessary. Please refer to one of the following manuals.

- MELSEC iQ-R Module Configuration Manual (SH-081262ENG)
- Safety Guidelines (IB-0800525)

Certification marks on the side of the programmable controller indicate compliance with the relevant regulations.

Additional measures

To ensure that this product maintains the EMC and Low Voltage Directives, Ethernet cables, RS-232 cables, and USB cables must meet the noise immunity standards.

- Ethernet cable
  Use a shielded twisted pair cable for connection to the 10BASE-T, 100BASE-TX, or 1000BASE-T connector.

- RS-232 cable
  For RS-232 cable, be sure to ground the shield part of a shield cable.
## CONTENTS

SAFETY PRECAUTIONS ................................................................. 1
CONDITIONS OF USE FOR THE PRODUCT ........................................ 9
CONSIDERATIONS FOR USE ....................................................... 9
INTRODUCTION ................................................................. 10
COMPLIANCE WITH EMC AND LOW VOLTAGE DIRECTIVES ................. 10
RELEVANT MANUALS ............................................................ 13
TERMS ................................................................. 14

### CHAPTER 1 PART NAMES

### CHAPTER 2 SPECIFICATIONS

2.1 Dot Matrix LED Display Specifications ....................................... 20

### CHAPTER 3 SYSTEM CONFIGURATION

3.1 Overall Configuration ....................................................... 21
3.2 Peripheral Configuration ................................................... 22
   Available software ....................................................... 23
   SD memory card .......................................................... 24

### CHAPTER 4 WIRING

4.1 Ethernet Ports ............................................................... 25
4.2 RS-232 Interface ............................................................ 27
4.3 USB Connector ............................................................. 28
4.4 HMI (GOT). ................................................................. 29
   Connection route ....................................................... 29

### CHAPTER 5 FUNCTION LIST

### CHAPTER 6 PROCEDURE BEFORE OPERATION

6.1 Initialization ............................................................... 34
6.2 Performing Hardware Diagnostics ........................................... 36
   Hardware diagnostics timing ......................................... 36
   Diagnostics types ...................................................... 36
   Performing diagnostics .............................................. 37
   Operation at error detection ......................................... 40
6.3 Inserting and Removing SD Memory Card ................................... 41
   How to insert an SD memory card .................................. 41
   How to remove an SD memory card .................................. 41
6.4 Connecting and Disconnecting USB Mass Storage Class-compliant Device ........................................ 42
   How to connect a USB device ......................................... 42
   How to disconnect a USB device ..................................... 42
6.5 Switch Operation ........................................................... 43
   RESET/STOP/RUN switch ............................................ 43
   MODE/SELECT switch ................................................ 44
6.6 Creating a Project .......................................................... 46
6.7 Connecting to Personal Computer ........................................... 46
6.8 Setting Parameters ........................................................ 47
6.9 Writing Parameters to C Controller Module ................................ 49
6.10 Creating User Program ................................................................. 50
    Programming procedure ......................................................... 50
6.11 Checking VxWorks Image File .................................................. 53
6.12 Creating Script File ............................................................... 54
6.13 Registering User Program ....................................................... 56
6.14 Troubleshooting ................................................................. 58
    Troubleshooting procedure ...................................................... 58
    Checking with CW Configurator .............................................. 59

CHAPTER 7 MAINTENANCE AND INSPECTION 62
7.1 Daily Inspection ................................................................. 62
7.2 Periodic Inspection ............................................................... 63

CHAPTER 8 OPERATION EXAMPLE 64
8.1 System configuration example .................................................. 64
8.2 Setting the Module ............................................................... 65
    Initializing the C Controller module ...................................... 65
    Setting parameters ............................................................. 65
8.3 Programming ................................................................. 72
    Program example and control description .............................. 72
    Creating a project ............................................................. 75
    Preparing a user program ................................................... 84
8.4 Checking Operations ........................................................... 101
    Enabling outputs (Y) from the user program ......................... 101
    Checking operations with the dot matrix LED and lamps ......... 102

APPENDIX 103
Appendix 1 External Dimensions .................................................. 103
Appendix 2 How to Use MELSEC-Q Series Modules .......................... 104
    Window change in CW Configurator ...................................... 104
    Setting procedure ............................................................. 107
    Considerations ............................................................... 108
Appendix 3 Handling of Batteries ................................................ 110
    Transport guidelines ........................................................ 110
    Handling of batteries and devices with built-in batteries in EU member states .......................................................... 110
    Disposal of a battery ......................................................... 110
Appendix 4 Enabling Parameters .................................................. 112
    Corresponding device list .................................................. 112

INDEX 114
REVISIONS ................................................................. 116
WARRANTY ................................................................. 117
TRADEMARKS ............................................................... 118
This manual does not include detailed information on the following:
- General specifications
- Available CPU modules and the number of mountable modules
- Available remote head modules and the number of mountable modules
- Installation

For details, refer to the following manual.

**MELSEC iQ-R Module Configuration Manual**

It should be noted that the terms in the left column shall be replaced with the one in the right column.

<table>
<thead>
<tr>
<th>Term</th>
<th>Replaced term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programmable controller</td>
<td>C Controller module</td>
</tr>
<tr>
<td>Programmable controller system</td>
<td>C Controller system</td>
</tr>
</tbody>
</table>

**e-Manual** refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated tool.

**e-Manual** has the following features:
- Required information can be cross-searched in multiple manuals.
- Other manuals can be accessed from the links in the manual.
- Hardware specifications of each part can be found from the product figures.
- Pages that users often browse can be bookmarked.
### TERMS

Unless otherwise specified, this manual uses the following terms.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base unit</td>
<td>A generic term for main base units, extension base units, and RQ extension base units.</td>
</tr>
<tr>
<td>C Controller module</td>
<td>A generic term for MELSEC iQ-R series C Controller modules.</td>
</tr>
<tr>
<td>C Controller module dedicated function</td>
<td>A dedicated function library offered by a C Controller module. It is used to control a C Controller module.</td>
</tr>
<tr>
<td>C intelligent function module</td>
<td>A generic term for MELSEC iQ-R series C intelligent function modules.</td>
</tr>
<tr>
<td>CC-Link IE Controller Network module</td>
<td>A generic term for the following modules:</td>
</tr>
<tr>
<td></td>
<td>• RJ71GP21-SX CC-Link IE Controller Network modules</td>
</tr>
<tr>
<td></td>
<td>• RJ71GP21S-SX CC-Link IE Controller Network modules</td>
</tr>
<tr>
<td></td>
<td>• RJ71EN71 (when a CC-Link IE Controller Network function is used.)</td>
</tr>
<tr>
<td>CC-Link IE Field Network module</td>
<td>A generic term for the following modules:</td>
</tr>
<tr>
<td></td>
<td>• RJ71GF11-T2 CC-Link IE Field Network master/local modules</td>
</tr>
<tr>
<td></td>
<td>• RJ71EN71 (when a CC-Link IE Field Network function is used).</td>
</tr>
<tr>
<td></td>
<td>• Simple motion modules</td>
</tr>
<tr>
<td>CC-Link IE module</td>
<td>A generic term for CC-Link IE Controller Network modules, CC-Link IE Field Network modules, and CC-Link IE TSN modules.</td>
</tr>
<tr>
<td>CC-Link IE TSN master/local module</td>
<td>RJ71GN11-T2</td>
</tr>
<tr>
<td>CC-Link IE TSN module</td>
<td>A generic term for RJ71GN11-T2 and motion modules.</td>
</tr>
<tr>
<td>CPU module</td>
<td>A generic term for MELSEC iQ-R series CPU modules.</td>
</tr>
<tr>
<td>CW Configurator</td>
<td>A generic product name for SWnDND-RCCPU. ('n' indicates its version.)</td>
</tr>
<tr>
<td>CW Workbench</td>
<td>An abbreviation for a C Controller module and C intelligent function module engineering tool, CW Workbench.</td>
</tr>
<tr>
<td>CW-Sim</td>
<td>An abbreviation for VxWorks simulator that can operate and debug C Controller module programs and C intelligent function module programs on a personal computer with CW Workbench installed, without connecting to an actual device (target).</td>
</tr>
<tr>
<td>CW-Sim Standalone</td>
<td>An abbreviation for VxWorks simulator that can operate C Controller module programs and C intelligent function module programs even on a personal computer without CW Workbench installed.</td>
</tr>
<tr>
<td>Data analysis function</td>
<td>A dedicated function library offered by a C Controller module and a C intelligent function module. It is used for data analysis processing.</td>
</tr>
<tr>
<td>Dedicated function library</td>
<td>A generic term for C Controller module dedicated functions, MELSEC data link functions, data analysis functions, statistical analysis functions, and motion module dedicated classes.</td>
</tr>
<tr>
<td>Global label</td>
<td>A label which is valid for user programs of a C Controller module. Module labels (global labels) of a motion module can be used.</td>
</tr>
<tr>
<td>GOT</td>
<td>An abbreviation for the Mitsubishi Graphic Operation Terminal.</td>
</tr>
<tr>
<td>I/O module</td>
<td>A generic term for input modules, output modules, I/O combined modules, and interrupt modules.</td>
</tr>
<tr>
<td>Intelligent function module</td>
<td>A module which has functions other than input and output, such as an A/D converter module or a D/A converter module.</td>
</tr>
<tr>
<td>MELSEC data link function</td>
<td>A dedicated function library offered by a C Controller module. It is used to access another CPU module as a connection target via network or in a multiple CPU system.</td>
</tr>
<tr>
<td>Module label</td>
<td>A label that represents one of memory areas (I/O signals and buffer memory areas) specific to each module in a given character string.</td>
</tr>
<tr>
<td>Network module</td>
<td>A generic term for the following modules:</td>
</tr>
<tr>
<td></td>
<td>• CC-Link IE Controller Network module</td>
</tr>
<tr>
<td></td>
<td>• CC-Link IE Field Network module</td>
</tr>
<tr>
<td></td>
<td>• CC-Link IE TSN module</td>
</tr>
<tr>
<td></td>
<td>• MELSECNET/H network module</td>
</tr>
<tr>
<td></td>
<td>• CC-Link module</td>
</tr>
<tr>
<td>Power supply module</td>
<td>A generic term for MELSEC iQ-R series power supply modules.</td>
</tr>
<tr>
<td>R12CCPU-V</td>
<td>An abbreviation for R12CCPU-V C Controller modules.</td>
</tr>
<tr>
<td>Statistical analysis function</td>
<td>A dedicated function library offered by a C Controller module and a C intelligent function module. It is used for statistical analysis processing.</td>
</tr>
<tr>
<td>Target device</td>
<td>A personal computer, GOT, or another CPU module to connect for data communication.</td>
</tr>
<tr>
<td>USB Mass Storage Class-compliant device</td>
<td>A USB device that is compliant with the standard for recognizing as a memory device (USB Mass Storage Class).</td>
</tr>
<tr>
<td>VxWorks</td>
<td>A product name for the real-time operating system manufactured by Wind River Systems, Inc.</td>
</tr>
</tbody>
</table>
This chapter shows the part names of a C Controller module.
### PART NAMES

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) | READY LED                | Indicates an operating mode.  
• ON: Normal operation mode  
• Flashing: Initializing (including the execution of the script file, "STARTUP.CMD")  
• OFF (for normal operation): Hardware failure or resetting  
• OFF (for diagnostic mode): Hardware diagnostic mode |
| (2) | ERROR LED                | Indicates an error status.  
• ON: Continuation error or major error  
• Flashing (for normal operation): Stop error  
• Flashing (for diagnostic mode): Hardware diagnostic error or initialization error  
• OFF: Normal operation |
| (3) | BUS RUN LED              | Indicates an operating status.  
• ON (for normal operation): RUN (state where output (Y) from a user program and writing to the buffer memory are permitted)  
• ON (for diagnostic mode): Hardware diagnostic mode  
• Flashing (low-speed): Performing the hardware diagnostics, configuring the module initialization setting, or performing initialization  
• Flashing (high-speed): Program/data memory shutdown complete  
• OFF: STOP/PAUSE (state where output (Y) from a user program and writing to the buffer memory are prohibited) |
| (4) | CARD RDY LED             | Indicates the availability of an SD memory card.  
• ON: Accessible (mounted)  
• Flashing: Mounting or unmounting an SD memory card  
• OFF: Inaccessible (not inserted or unmounted) |
| (5) | USER LED                 | The indication can be controlled with a user program. |
| (6) | USB RDY LED              | Indicates the availability of a connected USB Mass Storage Class-compliant device.  
• ON: Accessible (mounted)  
• Flashing: Mounting or unmounting a device  
• OFF: Inaccessible (not installed or unmounted) |
| (7) | RS SD/RD LED             | Indicates the data sending/receiving status for an RS-232 interface.  
• ON: Sending/receiving data  
• OFF: Not sending/receiving data |
| (8) | Dot matrix LED           | Indicates the setting content or results for the operation selection mode or hardware diagnostic mode.  
The indication can be controlled with a user program during normal operation. |
| (9) | SPEED LED                | Indicates the communication speed and the link status for Ethernet.  
• ON (orange): Linking-up (1G Mbps)  
• ON (green): Linking-up (100 Mbps)  
• OFF: Linking-down or linking-up (10 Mbps) |
| (10)| SD/RD LED                | Indicates the data sending/receiving status for Ethernet.  
• ON: Sending/receiving data  
• OFF: Not sending/receiving data |
| (11)| Ethernet port            | A port for connecting to an Ethernet device. |
| (12)| RS-232 connector         | A connector for connecting with an RS-232 supported device. |
| (13)| USB connector            | A connector for connecting with a USB-supported device. |
| (14)| Product information marking | Indicates the production information (16 digits) of the module. |
| (15)| RESET/STOP/RUN switch 1 | A switch to control the hardware operating status.  
• RUN: Changes the operating status of the module to RUN. (State where output (Y) from a user program and writing to the buffer memory are permitted)  
• STOP: Changes the operating status of the module to STOP. (State where output (Y) from a user program and writing to the buffer memory are prohibited)  
• RESET: Resets the module.  
The switch operation for each operating status is described in the following sections.  
For initialization  
[Page 34 Initialization](#)  
For hardware diagnostics  
[Page 36 Performing Hardware Diagnostics](#)  
For operation selection mode  
[Page 43 Switch Operation](#) |
| (16)| MODE/SELECT switch 1    | A switch to select a hardware mode.  
The switch operation for each operating status is described in the following sections.  
For initialization  
[Page 34 Initialization](#)  
For hardware diagnostics  
[Page 36 Performing Hardware Diagnostics](#)  
For operation selection mode  
[Page 43 Switch Operation](#) |
<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(17)</td>
<td>SD memory card slot</td>
<td>A slot to insert an SD memory card.</td>
</tr>
<tr>
<td>(18)</td>
<td>Slot cover</td>
<td>A cover of the SD memory card slot and the switches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open this cover to insert/remove an SD memory card or to operate the switches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close the cover unless inserting/removing an SD memory card or operating the switches to prevent foreign material intrusion such as dust.</td>
</tr>
</tbody>
</table>

*1 Operate the switches by a fingertip. Using tools such as a screwdriver may cause damage to the switches.
## SPECIFICATIONS

This chapter shows the performance specifications of C Controller modules.

<table>
<thead>
<tr>
<th>Item</th>
<th>R12CCPU-V</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware</strong></td>
<td></td>
</tr>
<tr>
<td>Endian format</td>
<td>Little endian</td>
</tr>
<tr>
<td>MPU</td>
<td>ARM® Cortex-A9 Dual Core</td>
</tr>
<tr>
<td>Memory capacity</td>
<td></td>
</tr>
<tr>
<td>Work RAM</td>
<td>256 MB&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>ROM</td>
<td>16 MB (program memory: 8 MB, data memory: 8 MB)</td>
</tr>
<tr>
<td>Backup RAM</td>
<td>4096 KB&lt;sup&gt;2&lt;/sup&gt; (File storage area for device/label memory&lt;sup&gt;2&lt;/sup&gt;: 3584 KB, For system: 512 KB)</td>
</tr>
<tr>
<td><strong>Software</strong></td>
<td></td>
</tr>
<tr>
<td>Operating system</td>
<td>VxWorks Version 6.9</td>
</tr>
<tr>
<td>Programming language</td>
<td>C language (C/C++)</td>
</tr>
<tr>
<td><strong>SD memory card slot</strong></td>
<td></td>
</tr>
<tr>
<td>Interface</td>
<td>SD/SDHC memory card (up to 16 GB)</td>
</tr>
<tr>
<td>Power supply</td>
<td>+3.3 VDC, up to 200 mA</td>
</tr>
<tr>
<td><strong>Ethernet port</strong></td>
<td></td>
</tr>
<tr>
<td>Number of channels</td>
<td>2</td>
</tr>
<tr>
<td>Interface</td>
<td>1000BASE-T, 100BASE-TX, 10BASE-T</td>
</tr>
<tr>
<td>Data transmission rate</td>
<td>1G Mbps, 100 Mbps, 10 Mbps</td>
</tr>
<tr>
<td>Number of cascaded connections&lt;sup&gt;3&lt;/sup&gt;</td>
<td>— Maximum 2 stages Maximum 4 stages</td>
</tr>
<tr>
<td>Maximum segment length</td>
<td>100 m (length between a hub and a node)</td>
</tr>
<tr>
<td>Communication method</td>
<td>Full-duplex/half-duplex</td>
</tr>
<tr>
<td>Transmission method</td>
<td>Base band</td>
</tr>
<tr>
<td>Applicable connector for external wiring</td>
<td>RJ45</td>
</tr>
<tr>
<td>Supported function</td>
<td>Auto-negotiation function (automatic recognition of the communication speed/communication method)</td>
</tr>
<tr>
<td>IP version</td>
<td>IPv4 supported</td>
</tr>
<tr>
<td><strong>RS-232 connector</strong></td>
<td></td>
</tr>
<tr>
<td>Number of channels</td>
<td>1</td>
</tr>
<tr>
<td>Interface</td>
<td>RS-232-compliant</td>
</tr>
<tr>
<td>Communication method</td>
<td>Full-duplex/half-duplex</td>
</tr>
<tr>
<td>Synchronization method</td>
<td>Asynchronous communication</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9600, 14400, 19200, 28800, 38400, 57600, 115200 bps</td>
</tr>
<tr>
<td>Transmission distance</td>
<td>Up to 15 m</td>
</tr>
<tr>
<td>Data format</td>
<td></td>
</tr>
<tr>
<td>Start bit</td>
<td>1</td>
</tr>
<tr>
<td>Data bit</td>
<td>7/8</td>
</tr>
<tr>
<td>Parity bit</td>
<td>1/None</td>
</tr>
<tr>
<td>Stop bit</td>
<td>1/2</td>
</tr>
<tr>
<td>Parity check</td>
<td>Yes (Even/Odd)/None</td>
</tr>
<tr>
<td>Sum check code</td>
<td>Yes/None</td>
</tr>
<tr>
<td>Transmission control</td>
<td>Flow control (RS/CS control)</td>
</tr>
<tr>
<td><strong>USB connector</strong></td>
<td></td>
</tr>
<tr>
<td>Interface</td>
<td>USB 2.0-compliant</td>
</tr>
<tr>
<td>Connector</td>
<td>Type A</td>
</tr>
<tr>
<td>Transfer rate</td>
<td>480 Mbps&lt;sup&gt;4&lt;/sup&gt; (High Speed)</td>
</tr>
<tr>
<td>Power supply</td>
<td>Bus power +5 VDC, up to 500 mA&lt;sup&gt;5&lt;/sup&gt;</td>
</tr>
<tr>
<td>Compiled standard</td>
<td>USB Mass Storage Class (up to 2 TB)</td>
</tr>
<tr>
<td><strong>Number of occupied I/O points</strong></td>
<td>4096 points</td>
</tr>
<tr>
<td><strong>Clock function</strong></td>
<td></td>
</tr>
<tr>
<td>Displayed information</td>
<td>Year, month, day, hour, minute, second, day of week (automatic leap year detection)</td>
</tr>
<tr>
<td>Precision</td>
<td>Daily error: -5.86 to +3.35 seconds (0 to 55 °C)</td>
</tr>
<tr>
<td></td>
<td>Daily error: -1.71 to +3.35 seconds (25 °C)</td>
</tr>
<tr>
<td><strong>Allowable momentary power failure time</strong></td>
<td>According to the power supply module</td>
</tr>
<tr>
<td><strong>5 VDC internal current consumption</strong></td>
<td>1.26 A&lt;sup&gt;5&lt;/sup&gt;</td>
</tr>
<tr>
<td><strong>External dimensions</strong></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>106 mm</td>
</tr>
<tr>
<td>Width</td>
<td>56 mm</td>
</tr>
<tr>
<td>Depth</td>
<td>110 mm</td>
</tr>
</tbody>
</table>
*1 Device area of device/label memory and module label area are secured in the work RAM area.
   For details on the memory configuration, refer to the following:
   MELSEC iQ-R C Controller Module User's Manual (Application)
*2 For details on the file storage area, refer to the following:
   MELSEC iQ-R C Controller Module User's Manual (Application)
*3 It is for a repeater hub.
   For a switching hub, consult the manufacturer of the hub used.
*4 Select an appropriate USB Mass Storage Class-compliant device to be connected to observe the current consumption limit.
*5 The current consumption of a USB is not included.

<table>
<thead>
<tr>
<th>Item</th>
<th>R12CCPU-V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>0.35 kg</td>
</tr>
</tbody>
</table>
## 2.1 Dot Matrix LED Display Specifications

This section shows the display specifications of dot matrix LED.

### Operation selection

<table>
<thead>
<tr>
<th>LED display</th>
<th>Operation</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVENT</td>
<td>An event is notified to the user program.</td>
<td>[Page 44 Selecting and performing an operation]</td>
</tr>
<tr>
<td>SD UNMOUNT</td>
<td>An SD memory card is unmounted forcibly.</td>
<td></td>
</tr>
<tr>
<td>USB UNMOUNT</td>
<td>A USB Mass Storage Class-compliant device is unmounted forcibly.</td>
<td></td>
</tr>
<tr>
<td>SD/USB UNMOUNT</td>
<td>An SD memory card and USB Mass Storage Class-compliant device are unmounted forcibly.</td>
<td></td>
</tr>
<tr>
<td>USER</td>
<td>Contents specified by the user are displayed on the dot matrix LED.</td>
<td></td>
</tr>
<tr>
<td>ERROR</td>
<td>An error code is displayed on the dot matrix LED.</td>
<td></td>
</tr>
<tr>
<td>CH1</td>
<td>The IP address of Ethernet port (CH1) is displayed on the dot matrix LED.</td>
<td></td>
</tr>
<tr>
<td>CH2</td>
<td>The IP address of Ethernet port (CH2) is displayed on the dot matrix LED.</td>
<td></td>
</tr>
</tbody>
</table>

### Hardware diagnostics

<table>
<thead>
<tr>
<th>LED display</th>
<th>Content</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-00</td>
<td>Diagnostic test for Mode 1 to Mode 6</td>
<td>[Page 36 Performing Hardware Diagnostics]</td>
</tr>
<tr>
<td>M-01</td>
<td>Program memory, data memory diagnostic test</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Device/label memory diagnostic test</td>
<td></td>
</tr>
<tr>
<td>M-02</td>
<td>Ethernet diagnostic test</td>
<td></td>
</tr>
<tr>
<td>M-03</td>
<td>SD memory card interface diagnostic test</td>
<td></td>
</tr>
<tr>
<td>M-04</td>
<td>RS-232 diagnostic test</td>
<td></td>
</tr>
<tr>
<td>M-05</td>
<td>USB diagnostic test</td>
<td></td>
</tr>
<tr>
<td>M-06</td>
<td>Bus diagnostic test</td>
<td></td>
</tr>
<tr>
<td>M-07</td>
<td>Dot matrix LED test</td>
<td></td>
</tr>
</tbody>
</table>

### Initialization

<table>
<thead>
<tr>
<th>LED display</th>
<th>Content</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>0010</td>
<td>Default IP setting</td>
<td>[Page 34 Initialization]</td>
</tr>
<tr>
<td>0011</td>
<td>Module initialization setting</td>
<td></td>
</tr>
</tbody>
</table>

### Firmware update

<table>
<thead>
<tr>
<th>LED display</th>
<th>Content</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>0020</td>
<td>Firmware update setting</td>
<td>[MELSEC iQ-R Module Configuration Manual]</td>
</tr>
</tbody>
</table>
3 SYSTEM CONFIGURATION

This chapter shows the overall configuration and considerations for system configuration of a C Controller system. When configuring a C Controller system, refer to the following manual.

MELSEC iQ-R Module Configuration Manual

3.1 Overall Configuration

The overall configuration of a C Controller system is shown below.

(1) C Controller module
(2) Programmable controller CPU, process CPU, motion CPU, or C Controller module
(3) Main base unit
(4) Extension cable
(5) Power supply module, I/O module, or intelligent function module
(6) Extension base unit or RQ extension base unit
3.2 Peripheral Configuration

The configuration with peripherals is shown below.

(1) Personal computer for maintenance (Telnet function and FTP function)
(2) User program development environment (CW Workbench and CW-Sim)
(3) SNTP server
(4) USB Mass Storage Class-compliant device
(5) SD memory card
(6) Connection via a built-in Ethernet (HMI (GOT), SLMP supported device)
(7) CW Configurator
(8) Various networks via a network module (CC-Link IE Controller Network, CC-Link IE Field Network, CC-Link IE TSN, MELSECNET/H network, and CC-Link)
(9) Connection via a built-in Ethernet (CC-Link IE Field Network Basic device)
• USB devices can be used for a C Controller module with the firmware version ‘03’ or later.
• Insert or connect peripherals to a C Controller module so that the specifications of both C Controller module and peripherals are met.
• For information on the access via each Network module and the access using Ethernet communication, refer to the following manual.
  MELSEC iQ-R C Controller Module User’s Manual (Application)

Available software

The following software can be used for the system of MELSEC iQ-R C Controller modules. (The manual of each software)

<table>
<thead>
<tr>
<th>Software package</th>
<th>Software</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CW Configurator</td>
<td>SW1DND-RCCPU-J</td>
<td>Version 1.00A or later</td>
</tr>
<tr>
<td></td>
<td>SW1DND-RCCPU-E</td>
<td></td>
</tr>
<tr>
<td>CW Workbench</td>
<td>SW1DND-CWWR-E/EZ/EVZ</td>
<td>Version 1.00A or later</td>
</tr>
<tr>
<td>CW-Sim</td>
<td>SW1DND-CWWSIMR-EZ</td>
<td>Version 1.00A or later</td>
</tr>
<tr>
<td>CW-Sim Standalone</td>
<td>SW1DND-CWWSIMSAR-E</td>
<td>Version 1.00A or later</td>
</tr>
<tr>
<td>Wind River Workbench</td>
<td>____</td>
<td>Version 3.3</td>
</tr>
<tr>
<td>GX Works3</td>
<td>SW1DND-GXW3-J</td>
<td>Version 1.007H or later</td>
</tr>
<tr>
<td></td>
<td>SW1DND-GXW3-E</td>
<td></td>
</tr>
<tr>
<td>GT Designer3</td>
<td>SW1DNC-GTWK3-J</td>
<td>Version 1.126G or later</td>
</tr>
<tr>
<td></td>
<td>SW1DNC-GTWK3-E</td>
<td></td>
</tr>
<tr>
<td>MT Works2</td>
<td>SW1DNC-MTW2-J</td>
<td>Version 1.110Q or later</td>
</tr>
<tr>
<td></td>
<td>SW1DNC-MTW2-E</td>
<td></td>
</tr>
</tbody>
</table>
SD memory card

Only one SD memory card can be inserted in a single C Controller module.

Available memory cards

The following Mitsubishi Electric Corporation's SD memory cards are available.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NZ1MEM-2GBSD</td>
<td>SD memory card 2 GB</td>
</tr>
<tr>
<td>NZ1MEM-4GBSD</td>
<td>SD memory card 4 GB</td>
</tr>
<tr>
<td>NZ1MEM-8GBSD</td>
<td>SD memory card 8 GB</td>
</tr>
<tr>
<td>NZ1MEM-16GBSD</td>
<td>SD memory card 16 GB</td>
</tr>
</tbody>
</table>

For commercially available SD memory cards, refer to the following document. Before using any commercially available SD memory card, it is advised to check and ensure that the card has no impact on the control of the system.

TECHNICAL BULLETIN No. FA-A-0023

Precautions

- Use the format function of CW Configurator to format an SD memory card.
- If any SD memory card other than the one listed above is used, data in the SD memory card may be corrupted or a system shutdown may occur.
- If the power is turned OFF or a C Controller module is reset, or the SD memory card is removed while the card is being accessed, data in the SD memory card may be corrupted. Always turn the power OFF or reset a C Controller module, or remove an SD memory card after the access to the card has been stopped.
This chapter shows the wiring methods to a C Controller module.

The bend radius of the cable near the connector or port should be at least four times longer than the cable’s outside diameter.

4.1 Ethernet Ports

This section shows the specification of a usable Ethernet cable and its wiring.

**Ethernet cable**

The following shows the specifications of the cables that can be used for connection with peripherals by using the Ethernet ports (CH1 and CH2). Cables compliant with IEEE802.3 10BASE-T/100BASE-TX/1000BASE-T standards can be used.

<table>
<thead>
<tr>
<th>Transmission rate</th>
<th>Unshielded twisted pair cable (UTP cable)</th>
<th>Shielded twisted pair cable (STP cable)</th>
<th>Crossing cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>1G Mbps</td>
<td>Category 5e or higher</td>
<td>Category 5e</td>
<td></td>
</tr>
<tr>
<td>100 Mbps</td>
<td>Category 5 or higher</td>
<td>Category 5 or 5e</td>
<td></td>
</tr>
<tr>
<td>10 Mbps</td>
<td>Category 3 or higher</td>
<td>Category 3 to 5e</td>
<td></td>
</tr>
</tbody>
</table>

**How to connect an Ethernet cable**

1. Check the insertion direction, and insert an Ethernet cable into the Ethernet port on the C Controller module until it clicks.
2. Check if the cable is securely connected by pulling it slightly.
3. Check that the SPEED LED of the Ethernet port is ON.

**Point**

- The time required from when an Ethernet cable is connected to when the SPEED LED turns ON may vary. Normally, it turns ON in a few seconds. However, it may take longer because the linking-up processing is repeated due to the device condition on the line.
- When the SPEED LED does not turn ON, check if the connected Ethernet cable has any failure.
- The SPEED LED is turned OFF when connecting with an Ethernet device on the network of which the transmission rate is 10 Mbps. Check the communication state by executing the PING test, etc.

**How to disconnect an Ethernet cable**

1. Pull out the Ethernet cable while pinching a clip on the connector.
IP address setting

To use the Ethernet port(s), set the IP address with CW Configurator.

[Navigation window] [Parameter] [CPU module] [Module Parameter] [Basic Settings] [Own Node Settings] [IP Address]

The default value is set to the IP address for the C Controller module before shipment and after initialization.

<table>
<thead>
<tr>
<th>Ethernet port</th>
<th>Default IP address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet port (CH1)</td>
<td>192.168.3.3</td>
</tr>
<tr>
<td>Ethernet port (CH2)</td>
<td>No setting</td>
</tr>
</tbody>
</table>

■ Checking method of IP address

The IP address set to a C Controller module can be checked with the operation selection mode or the diagnostic function of CW Configurator.

For details on the operation selection mode, refer to the following section.

Page 43 Switch Operation

Precautions

■ Considerations for IP address setting

The following shows the considerations for setting IP address.

- Set the same value for the network portion of the IP addresses for the target device to be connected and the Ethernet port.
- Set the different value for the network portion of CH1 and CH2 on the Ethernet port.
- A message to the target device (including response packets such as ping) is sent (responded) from the Ethernet port that has IP address of which network portion is the same.
- Do not set the IP address for a C Controller module with a user program.

■ Considerations for Ethernet device connection

The following shows the considerations for connecting Ethernet devices.

- When the C Controller module has been replaced and also IP address has been changed, then reset the Ethernet device too. If the Ethernet device holds the Ethernet address (MAC address) of the communication target, continuous communication may not be performed since the module replacement will change the Ethernet address (MAC address).
- Perform the troubleshooting in accordance with the manual for the Ethernet device when an error occurred on the Ethernet device.
- When Telnet or Shell of CW Workbench is connected to a C Controller module, an event/error message may be displayed once VxWorks detects a network error. For details on the displayed event/message, refer to the manual for VxWorks.
- Please ask Wind River Systems, Inc. for any event/message which cannot be handled.

■ Considerations for 1000BASE-T/100BASE-TX connection

In a high-speed data communication (1G Mbps/100 Mbps) via 1000BASE-T/100BASE-TX connection, a communication error may occur due to the effect of high frequency noise generated from the equipment other than C Controller system, depending on the installation environment. Take the following countermeasures on a C Controller module to eliminate the effect of high frequency noise when constructing a network system.

- Do not install the twisted pair cables together with the main circuit or power lines, or bring them close to each other.
- Make sure to place the twisted pair cable in a duct.
- In the environment where the cable is susceptible to noise, use a shielded twisted pair cable (STP cable).
- In an environment where the system is susceptible to noise, include a retry processing in a user program.
- Change the target device connected with the C Controller module to one which communicates at 10 Mbps, and decrease the data transmission rate.
4.2 RS-232 Interface

This section shows the specification of an RS-232 interface and its wiring.

RS-232 connector

The RS-232 interface specifications to connect to a target device are shown below.

<table>
<thead>
<tr>
<th>Connector shape</th>
<th>Pin No.</th>
<th>Signal code</th>
<th>Signal name</th>
<th>Signal direction (R12CCPU-V ⇔ RS-232 device)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>CD(DCD)</td>
<td>Data carrier detect</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>RD(RXD)</td>
<td>Received data</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>SD(TXD)</td>
<td>Transmitted data</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>ER(DTR)</td>
<td>Data terminal ready</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>SG</td>
<td>Signal ground</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>DR(DSR)</td>
<td>Data set ready</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>RS(RTS)</td>
<td>Request to send</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>CS(CTS)</td>
<td>Clear to send</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>CI(RI)</td>
<td>Ring indicator</td>
<td>←</td>
</tr>
</tbody>
</table>

Use the following product as a connection cable connector.

<table>
<thead>
<tr>
<th>Connector type</th>
<th>Manufacturer name</th>
<th>Model name</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-sub connector (Solder-connection type)</td>
<td>DDK Ltd.</td>
<td>17JE-13090-02(D8C)(-CG)</td>
</tr>
</tbody>
</table>

The specifications of fixing screws are as follows:
- Connector mating screw: #4-40UNC
- Tightening torque range: 0.15 to 0.20 N·m

Precautions

- Considerations for wiring RS-232 cable
  The following shows the considerations for wiring RS-232 cable.
  - Make sure that RS-232 connection cable shield is single-point grounded.
  - Do not short-circuit the FG and SG signals of the RS-232 connection cable. When the FG and SG signals are connected inside of the peripheral device, do not connect the FG signal to a C Controller module.
  - For connection method of peripheral device, check the specifications of the peripheral device.

- Considerations when connecting a target device
  The following shows the considerations when connecting a target device.
  - A reception error may occur on the target device connected to a C Controller module when the power for the C Controller module or the target device is turned ON or OFF.
  - A reception error occurs on the target device when the system on the target device side is booting while a C Controller module is transmitting data to the target device.
  - When an error occurred on the target device, take corrective actions in accordance with the manual for the target device.
4.3 USB Connector

This section shows the specification of a usable USB cable and its wiring.

**USB cable**

Use a USB cable supplied with a USB Mass Storage Class-compliant device.

The type of cable connector connectable with the USB connector is type A.

**Preventing USB cable from falling out**

Connected USB cable can be fixed to the hole for fixing band of the module by using a fixing band (recommended specification: width: 6 to 9 mm, thickness: 1 mm or less).

1. A through hole for a fixing band (1) is situated on the bottom of a C Controller module.

2. Pass the fixing band (2) through the hole.

3. Pass the USB cable (3) through the fixing band to fix.
4.4 HMI (GOT)

This section shows the connection method of GOT to a C Controller module.

Connection route

A C Controller module can be connected to GOT by any of the following routes.
- Connection using Ethernet port(s)
- Connection via a network module

Connection using Ethernet port(s)

Connect to GOT by using the Ethernet port(s) (CH1 and CH2).

Connection via a network module

Connection to GOT is available via any of the following network modules.
- CC-Link IE Controller Network
- CC-Link IE Field Network
- CC-Link (via an intelligent device station, G4)

For the connection methods via a network, refer to the manual for the network module used.
## 5 FUNCTION LIST

This chapter shows the functions of C Controller modules.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program monitoring (WDT) function</td>
<td>To monitor and detect errors on the hardware and user programs using the watchdog timer (WDT), an internal timer of a C Controller module.</td>
</tr>
<tr>
<td>Clock function</td>
<td>To manage the time for the functions performed by the system such as date for the event history function.</td>
</tr>
<tr>
<td>Remote operation function</td>
<td>To change the operating status of a C Controller module with CW Configurator or user program, or by an external device using SLMP.</td>
</tr>
<tr>
<td>Device access function</td>
<td>To read/write data from/to devices and buffer memory of the intelligent function module which is controlled by a CPU module or a C Controller module.</td>
</tr>
<tr>
<td>Interrupt function to a C Controller module</td>
<td>To perform an interrupt routine by an interrupt request from an input module, an intelligent function module, or an interrupt module.</td>
</tr>
<tr>
<td>Fixed cycle processing function</td>
<td>To perform refresh with a network module and perform data communication with an external device.</td>
</tr>
<tr>
<td>Inter-module synchronization function</td>
<td>To perform synchronous control among each module.</td>
</tr>
<tr>
<td>Label communication function</td>
<td>To access other stations by using labels.</td>
</tr>
<tr>
<td>Data analysis function</td>
<td>To perform data analysis processing such as fast Fourier transform, digital filter operation, and calculation of a standard deviation.</td>
</tr>
<tr>
<td>Output mode setting of STOP to RUN</td>
<td>To set the output (Y) mode when the operating status of a C Controller module is switched from STOP to RUN.</td>
</tr>
<tr>
<td>Memory card function</td>
<td>Boot operation To transfer files stored in an SD memory card to the CPU built-in memory when turning the power OFF and ON, or resetting the C Controller module.</td>
</tr>
<tr>
<td>Enable/disable the use of file/data on memory card</td>
<td>To set whether to use files/data stored on a memory card or not.</td>
</tr>
<tr>
<td>RAS function</td>
<td>Self-diagnostic function To diagnose any abnormality by a C Controller module itself.</td>
</tr>
<tr>
<td>Error clear function</td>
<td>To clear continuation errors occurred in a batch.</td>
</tr>
<tr>
<td>Event history function</td>
<td>To collect and save the operation and error information of each module. The saved event history can be viewed in chronological order.</td>
</tr>
<tr>
<td>Security function</td>
<td>To prevent assets stored in a personal computer or a module from being stolen, falsified, operated incorrectly, and executed improperly due to unauthorized access from a third party.</td>
</tr>
<tr>
<td>MELSEC data link function setting function</td>
<td>To set required items for using the MELSEC data link function.</td>
</tr>
<tr>
<td>Access function using network module</td>
<td>Cyclic transmission To perform data communication periodically between stations on a network using link devices.</td>
</tr>
<tr>
<td>Transient transmission</td>
<td>To perform data communication with other stations when a communication request is issued. Communication with different network can also be performed.</td>
</tr>
<tr>
<td>Access function of each network module</td>
<td>To transmit data to the devices on the network via a Network module controlled by a C Controller module.</td>
</tr>
<tr>
<td>Ethernet communication function</td>
<td>Connection with MELSOFT product or GOT To monitor or test a C Controller module via Ethernet.</td>
</tr>
<tr>
<td>Communication with SLMP</td>
<td>To read/write device data from/to a personal computer or HMI using SLMP.</td>
</tr>
<tr>
<td>FTP function</td>
<td>To operate files in a C Controller module from a target device with the FTP client function.</td>
</tr>
<tr>
<td>Time setting function</td>
<td>To set the time on a C Controller module by collecting time information with the specified timing from the time information server (SNTP server) connected to LAN.</td>
</tr>
<tr>
<td>Telnet function</td>
<td>To perform remote debugging of a C Controller module with Telnet tool on a personal computer.</td>
</tr>
<tr>
<td>Security function</td>
<td>To apply optimal security according to the network environment by restricting the access to a C Controller module for each communication route.</td>
</tr>
<tr>
<td>Motion module control function</td>
<td>To control a motion module from a C Controller module.</td>
</tr>
<tr>
<td>CC-Link IE Field Network Basic function</td>
<td>To use for CC-Link IE Field Network Basic. (LICC-Link IE Field Network Basic Reference Manual)</td>
</tr>
<tr>
<td>Multiple CPU system function</td>
<td>Out-of-group I/O fetch To access a module which is not controlled by a CPU module to import the input/output (X/Y) or access the buffer memory of an intelligent function module.</td>
</tr>
<tr>
<td>Operation setting</td>
<td>To set operations for the multiple CPU system function.</td>
</tr>
<tr>
<td>Data communication between CPU modules</td>
<td>To perform data communication among CPU modules in a multiple CPU system.</td>
</tr>
<tr>
<td>Interrupt from another CPU</td>
<td>To restart a user program which is waiting for an interrupt event.</td>
</tr>
<tr>
<td>Issuing an interrupt to another CPU</td>
<td>To issue an interrupt to another CPU from the user program of a C Controller module.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Firmware update function</td>
<td>To update the firmware of a C Controller module.</td>
</tr>
<tr>
<td></td>
<td>(MELSEC iQ-R Module Configuration Manual)</td>
</tr>
</tbody>
</table>
This chapter shows the startup procedure and program execution of a C Controller module.
At the time of the first operation of a C Controller module, check that there is no error on the module using the hardware diagnostic, then start the system.

**Performing hardware diagnostics**

1. Mounting a C Controller module
   Mount a power supply module and a C Controller module on a base unit. ([MELSEC iQ-R Module Configuration Manual](#))

2. Turning the power of the system ON
   Check the wiring and the supply voltage of the power supply before the system is powered ON.

3. Initializing the C Controller module
   Initialize the C Controller module. ([Page 34 Initialization](#))

4. Performing hardware diagnostics
   Check the hardware status of the C Controller module. ([Page 36 Performing Hardware Diagnostics](#))

**Starting the C Controller system**

1. Inserting an SD memory card
   Insert an SD memory card to the C Controller module as necessary. ([Page 41 Inserting and Removing SD Memory Card](#))

2. Mounting modules and wiring for each device
   Mount modules on the base unit, and wire for each device. ([MELSEC iQ-R Module Configuration Manual](#))

3. Turning the power of the system ON
   Check the following items, and then turn ON the power supply.
   - The wiring and supply voltage of the power supply are in the required range.
   - The C Controller module is placed into the STOP state.

4. Creating a project
   Create a project for the C Controller module to be used with a personal computer on which CW Configurator has been installed. ([Page 46 Creating a Project](#))

5. Connecting a personal computer to the C Controller module
   Connect the personal computer on which CW Configurator has been installed to the C Controller module. ([Page 46 Connecting to Personal Computer](#))

6. Setting parameters
   Set the system parameter, CPU parameter, and module parameter. ([Page 47 Setting Parameters](#))
   When using an SD memory card function, or when mounting an intelligent function module, also set parameters other than the above. ([User's manual (Application) for each module](#))

7. Writing parameters to the C Controller module
   Write the parameters set with CW Configurator to the C Controller module. ([Page 49 Writing Parameters to C Controller Module](#))

8. Resetting the C Controller system
   Reset the system by one of the following methods.
   - Turning the power of the system OFF and ON
   - Resetting the C Controller module ([Page 43 Switch Operation](#))
9. Checking errors
Check the READY LED and ERROR LED on the C Controller module. When any error occurred, perform the troubleshooting. When any errors caused by factors other than the C Controller module occurred, refer to the manual for each module used.

10. Creating a user program
Create a user program
- Create a user program and debug it. (Page 50 Creating User Program)
- Create a script file. (Page 54 Creating Script File)
- Register the user program and the script file to the C Controller module. (Page 56 Registering User Program)

11. Resetting the C Controller system
Reset the system by one of the following methods.
- Turning the power of the system OFF and ON
- Resetting the C Controller module (Page 43 Switch Operation)

12. Executing the program
Change the operating status of the C Controller module to RUN, and check that the BUS RUN LED turns ON. (Page 43 Switch Operation)
6.1 Initialization

Initialize a C Controller module in the following cases.

- First operation
- The C Controller module does not start by the execution of the script file registered in the program memory
- The user name/password set to the C Controller module has been forgotten

The data in the program memory, device/label memory, and data memory are deleted during the process of initialization. Back up all necessary data in advance.

Procedure for initialization

Check that the RESET/STOP/RUN switch is positioned at the center i.e. on the "Stop" position at first.

1. Put and hold the MODE/SELECT switch (1) on the MODE position.

2. Turn the power of the C Controller module ON. The BUS RUN LED (2) turns ON, and "M-00" is displayed on the dot matrix LED.

   **Point**
   When the power of the C Controller module is ON, the ERROR LED may flash and an error code may be displayed on the dot matrix LED.
   ([Page 35 Abnormal completion of initialization process])

3. Release the MODE/SELECT switch (1) and put it back to the center position.

4. Set the MODE/SELECT switch (1) to the SELECT position. Every time the switch is set to the SELECT position, the value of mode displayed on the dot matrix LED is changed. Repeat this switch movement until "0011" is displayed on the dot matrix LED.

5. Set the RESET/STOP/RUN switch (3) to the RUN position. The selected mode is executed. The BUS RUN LED (2) will be flashing during initialization.

6. Check that the BUS RUN LED (2) turns ON and "0000" is displayed on the dot matrix LED, then reset the C Controller module.
   ([Page 43 RESET/STOP/RUN switch])
6. PROCEDURE BEFORE OPERATION

6.1 Initialization

Do not reset the C Controller module during initialization. Perform the initialization again if the module has been reset in error.

Abnormal completion of initialization process

Upon abnormal completion of the initialization, the ERROR LED will be flashing, and the READY LED and USER LED turn ON. In the case of abnormal completion, perform the initialization again.

The ERROR LED flashes, and the value other than '0000' is displayed on the dot matrix LED

The ERROR LED flashes, and the value corresponding to the error is displayed.

<table>
<thead>
<tr>
<th>Dot matrix LED</th>
<th>Error name</th>
<th>Cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>E100</td>
<td>Initialization function execution error</td>
<td>The execution of the initialization function failed.</td>
<td>Execute the initialization again.</td>
</tr>
<tr>
<td>E101</td>
<td>Firmware update function execution error</td>
<td>For details on the firmware update function, refer to the following manual.</td>
<td></td>
</tr>
<tr>
<td>E102</td>
<td></td>
<td></td>
<td>MELSEC iQ-R Module Configuration Manual</td>
</tr>
</tbody>
</table>

For an abnormal completion, check the error corresponding to the value displayed on the dot matrix LED, and take the appropriate corrective action. If the error occurs again, please consult your local Mitsubishi representative.

Module status after initialization

After initialization, the status of the C Controller module will be as follows:

Default IP setting

- The registered script file stops to be executed.\(^1\)
- The IP address for the C Controller module is set to the default. (Page 25 Ethernet Ports)

\(^1\) The script file name is renamed as "STARTUP.BAK", and deregistered.

Module initialization setting

- Default parameters are set to the data memory.
- The program memory, device/label memory, and data memory are formatted.
- A security password is initialized. (Default password: password)
6.2 Performing Hardware Diagnostics

Diagnose the hardware of a C Controller module.

Hardware diagnostics timing

Use the hardware diagnostics in the following cases.
- First operation
- Troubleshooting

Do not turn the power OFF, or reset the C Controller module during the hardware diagnostics. Doing so may cause abnormal startup of the C Controller module. If it does not start normally, perform the initialization.

Diagnostics types

The modes of hardware diagnostics are shown below.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Dot matrix LED</th>
<th>Diagnostic item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>M-00</td>
<td>Diagnostic test for Mode 1 to Mode 6</td>
<td>To perform diagnostic test in the order from Mode 1 to Mode 6.</td>
</tr>
<tr>
<td>1</td>
<td>M-01</td>
<td>Program memory, data memory diagnostic test</td>
<td>To read data in the program memory and data memory, and perform error detection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Device/label memory diagnostic test</td>
<td>To write/read test data to/from the device/label memory, and check by verifying the data.</td>
</tr>
<tr>
<td>2</td>
<td>M-02</td>
<td>Ethernet diagnostic test</td>
<td>To diagnose the Ethernet port (CH1 and CH2) status.</td>
</tr>
<tr>
<td>3</td>
<td>M-03</td>
<td>SD memory card interface diagnostic test</td>
<td>To diagnose the SD memory card slot status.</td>
</tr>
<tr>
<td>4</td>
<td>M-04</td>
<td>RS-232 diagnostic test</td>
<td>To perform a self-loopback test for an RS-232 connector. The wiring for self-loopback is required.</td>
</tr>
<tr>
<td>5</td>
<td>M-05</td>
<td>USB diagnostic test</td>
<td>To diagnose the USB connector status.</td>
</tr>
<tr>
<td>6</td>
<td>M-06</td>
<td>Bus diagnostic test</td>
<td>To write/read/verify the memory of the internal bus and register.</td>
</tr>
<tr>
<td>7</td>
<td>M-07</td>
<td>Dot matrix LED test</td>
<td>To show the dot matrix LED test display.</td>
</tr>
</tbody>
</table>
Performing diagnostics

The following shows the procedure for hardware diagnostics.

**Preparation**

Perform the following before the hardware diagnostics.

1. Mount the modules.
   Mount a power supply module and a C Controller module on a base unit.

   - The hardware diagnostics can be performed even when a C Controller module is not mounted on the CPU slot.
   - To perform the hardware diagnostics with the module mounted on the slot other than the CPU slot, mount another CPU module on the CPU slot. Although an error may be detected on the mounted CPU module, the hardware diagnostics can be performed.

2. Check the wiring.
   - Check that the power supply cable is wired properly.
   - Do not connect any cable other than power supply cable.

3. Make the necessary preparations for each diagnostic.

4. Power ON.
   - Check that the power supply voltage is within the range of the specifications.
   - Check that the RESET/STOP/RUN switch is put on the STOP position.

**Preparation required for each diagnostic**

Perform the following before starting each mode (0 to 7) of hardware diagnostics.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Make all of the preparations required for Mode 1 to 6.</td>
</tr>
<tr>
<td>1</td>
<td>Back up the data in the program memory, data memory, and device/label memory.</td>
</tr>
<tr>
<td>2</td>
<td>Check that no cable is connected to the Ethernet port.</td>
</tr>
<tr>
<td>3</td>
<td>Check that no SD memory card is inserted.</td>
</tr>
<tr>
<td>4</td>
<td>Connect a cable to the RS-232 connector. The connector pin arrangement and cable connection are shown below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>(1)</th>
<th>(2)</th>
<th>(3)</th>
<th>(4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CD(DCD)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RD(RXD)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>SD(TXD)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ER(DTR)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>SG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>DR(DSR)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RS(RTS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>CS(CTS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>CI(RI)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(1) Connector
(2) Pin number
(3) Abbreviation of signal code
(4) Cable connection

5. Check that no cable is connected to the USB connector.

6. No preparation required for this mode.
**Mode selection**

The following shows how to select a mode.

1. Set the RESET/STOP/RUN switch to the RESET position, and keep it up to the step 4.
2. Check that all LEDs turned OFF.
3. Set the MODE/SELECT switch to the MODE position, and keep it up to the step 6.
4. Release the RESET/STOP/RUN switch and put it back to the STOP position.
5. The BUS RUN LED turns ON, and "M-00" is displayed on the dot matrix LED.
6. Release the MODE/SELECT switch and put it back to the center position.
7. Set the MODE/SELECT switch to the SELECT position, and select the desired diagnostic mode.
   Every time the switch is set to the SELECT position, the value of mode displayed on the dot matrix LED is changed.
   Repeat this switch movement until the dot matrix LED displays the desired diagnostic mode.

**Mode execution**

The following shows how to execute the selected mode.

### Executing Mode 0 to 6

1. Set the RESET/STOP/RUN switch to the RUN position.
   - While Mode 0 or 1 is being executed, the BUS RUN LED will be flashing, and the current mode and its progress are displayed alternatively on the dot matrix LED.
   (Example): "M-01" (diagnostic mode) ← displaying alternatively → "0050" (progress: %)
   - While Mode 2 to 6 is being executed, the BUS RUN LED will be flashing, and the current mode is displayed on the dot matrix LED.
2. Check that the BUS RUN LED turns ON.
   When the test is completed normally, "0000" is displayed on the dot matrix LED.
3. Turn the power OFF.

---

**Point**

Before performing the steps of mode execution, put the RESET/STOP/RUN switch back to the STOP position, if the switch is in the RUN position.
6.2 Performing Hardware Diagnostics

1. Set the RESET/STOP/RUN switch to the RUN position.
2. Set the MODE/SELECT switch to the SELECT position.
Every time the switch is set to the SELECT position, the lighting status on the dot matrix LED switches.

3. Turn the power OFF.
Check visually that there is no inactive dot exists on the dot matrix LED. If there is any inactive LED, the C Controller module may have hardware failure. Please consult your local Mitsubishi representative.

Operation at error detection

The error contents displayed at the time of error detection are shown below.

Dot matrix LED displays other than "0000"

The ERROR LED start flashing and the value corresponding to the diagnostics on which an error occurred will be displayed at the time of error detection during diagnostics or setting. Only flashing of the ERROR LED without dot matrix LED display means a system error.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Dot matrix LED</th>
<th>Diagnostics on which an error occurred</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>E010</td>
<td>Program memory, data memory diagnostic test</td>
</tr>
<tr>
<td></td>
<td>E020</td>
<td>Device/label memory diagnostic test</td>
</tr>
<tr>
<td></td>
<td>E030</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E040</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>E050</td>
<td>Ethernet diagnostic test (CH1)</td>
</tr>
<tr>
<td></td>
<td>E060</td>
<td>Ethernet diagnostic test (CH2)</td>
</tr>
<tr>
<td>3</td>
<td>E070</td>
<td>SD memory card interface diagnostic test</td>
</tr>
<tr>
<td>4</td>
<td>E080</td>
<td>RS-232 diagnostic test*1</td>
</tr>
<tr>
<td>5</td>
<td>E090</td>
<td>USB diagnostic test</td>
</tr>
<tr>
<td>6</td>
<td>E0A0</td>
<td>Bus diagnostic test</td>
</tr>
<tr>
<td></td>
<td>E0B0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E0C0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E0D0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E0E0</td>
<td></td>
</tr>
</tbody>
</table>

*1 An error may occur if a wiring cable is not connected properly. Connect the cable or wire the cable correctly again, and perform the diagnostics for Mode 4.

The diagnostics or setting will be terminated at the time of abnormal completion. Retry the diagnostics or setting. If an error is detected after the abnormal completion, the C Controller module may have its hardware failure. Please consult your local Mitsubishi representative.
6.3 Inserting and Removing SD Memory Card

Insert or remove an SD memory card by following the procedure below. Failure to do so may cause data corruption in the SD memory card.

**Point**

Change the MODE/SELECT switch operation to “SD UNMOUNT” or “SD/USB UNMOUNT” before removing the SD memory card. (Page 43 Switch Operation)

---

**How to insert an SD memory card**

1. Insert an SD memory card (1) straight into the SD memory card slot with its cutout pointed down. Make sure it is not uplifted after inserting it.
2. The CARD RDY LED (2) keeps flashing until the SD memory card is ready to be used.
3. Once the CARD RDY LED (2) turns ON, the card can be used.

**How to remove an SD memory card**

1. Check that no SD memory card is accessed.
2. Hold the MODE/SELECT switch (1) in the SELECT position to unmount the SD memory card. The CARD RDY LED (2) is flashing, which indicates that process of unmounting SD memory card is in progress, and later upon successful completion, the LED turns OFF.
3. Push the SD memory card (3) in once, and pull it out straight.

**Point**

An SD memory card can also be unmounted with a user program using the C Controller module dedicated function (CCPU_UnmountMemoryCard).

---

**Precautions**

Do not perform the following operations while accessing the files in an SD memory card. Doing so may result in data corruption in the SD memory card or file system error.

- Turning the power of the system OFF
- Turning the power OFF and ON, or resetting the C Controller module
- Unmounting or removing the SD memory card
6.4 Connecting and Disconnecting USB Mass Storage Class-compliant Device

Connect or disconnect a USB Mass Storage Class-compliant device by following the procedure below. Failure to do so may cause data corruption in the USB Mass Storage Class-compliant device.

**Point**
Change the MODE/SELECT switch operation to "USB UNMOUNT" or "SD/USB UNMOUNT" before disconnecting the USB Mass Storage Class-compliant device. (Page 43 Switch Operation)

---

**How to connect a USB device**

1. Connect a connector of USB Mass Storage Class-compliant device or USB cable to the USB connector (1). Firmly insert the connector to prevent it from falling out.

2. The USB RDY LED (2) keeps flashing until the USB Mass Storage Class-compliant device is ready to be used.

3. Once the USB RDY LED (2) turns ON, the USB Mass Storage Class-compliant device can be used.

---

**How to disconnect a USB device**

1. Check that no USB Mass Storage Class-compliant device is accessed.

2. Hold the MODE/SELECT switch in the SELECT position to unmount the USB Mass Storage Class-compliant device. The USB RDY LED (1) is flashing, which indicates that process of unmounting USB Mass Storage Class-compliant device is in progress, and later upon successful completion, the LED turns OFF.

3. Disconnect the USB Mass Storage Class-compliant device or USB cable that is inserted to the USB connector (2).

---

**Point**
A USB Mass Storage Class-compliant device can also be unmounted with a user program using C Controller module dedicated functions (CCPU_UnmountMemoryCard).

---

**Precautions**

Do not perform the following operations while accessing the files in a USB Mass Storage Class-compliant device. Doing so may result in data corruption in the USB Mass Storage Class-compliant device or file system error.

- Turning the power of the system OFF
- Turning the power OFF and ON, or resetting the C Controller module
- Unmounting/ejecting the USB Mass Storage Class-compliant device
6.5 Switch Operation

This section explains the method for changing the operating status of a C Controller module.

**RESET/STOP/RUN switch**

The operating status of a C Controller module can be changed using the RESET/STOP/RUN switch.
- By setting the switch to the RUN position, the operating status is changed to RUN. (Status where output (Y) from a user program and writing to the buffer memory are permitted)
- By setting the switch to the STOP position, the operating status is changed to STOP. (Status where output (Y) from a user program and writing to the buffer memory are prohibited)
- Operating the switch with the following procedure resets a C Controller module.

1. Hold the RESET/STOP/RUN switch (1) in the RESET position.
2. Check that all LEDs turn OFF after the ERROR LED (2) flashes several times.
3. Release the RESET/STOP/RUN switch (1) and put it back to the STOP position.

**Point**

Operate the RESET/STOP/RUN switch by fingertip.

Using tools such as a screwdriver may cause damage on the switch.
**MODE/SELECT switch**

With the MODE/SELECT switch, the mode can be switched between the operation selection mode and normal operation mode, and the operation selected in the operation selection mode can be performed.

The 'notification/unmount' and 'information display on the dot matrix LED' can be performed in the operation selection mode.

Make sure that the C Controller module is in normal operation before selecting its operation.

### Selecting and performing an operation

The following shows how to select and perform the operation.

1. Hold the MODE/SELECT switch (1) in the MODE position.

2. The selectable operation is displayed on the dot matrix LED.
   (In the operation selection mode, the lighting status of LED display is reversed.)

3. Release the MODE/SELECT switch (1) and put it back to the center position.

4. Set the MODE/SELECT switch (1) to the SELECT position.
   Every time the switch is set to the SELECT position, the value of mode displayed on the dot matrix LED is changed. Repeat this switch movement until the desired operation is displayed on the dot matrix LED.

5. Hold the MODE/SELECT switch (1) in the SELECT position.

6. The selected operation is performed.

---

**Point**

The mode is switched to the normal operation mode by holding the MODE/SELECT switch in the MODE position while selecting an operation.

<table>
<thead>
<tr>
<th>LED display</th>
<th>Operation</th>
<th>Operation at execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVENT</td>
<td>Notifies an event to the user program. (Default)</td>
<td>Notification/unmount²</td>
</tr>
<tr>
<td>SD UNMOUNT</td>
<td>Unmounts the SD memory card forcibly.</td>
<td></td>
</tr>
<tr>
<td>USB UNMOUNT</td>
<td>Unmounts the USB Mass Storage Class-compliant device forcibly.</td>
<td></td>
</tr>
<tr>
<td>SD/USB UNMOUNT</td>
<td>Unmounts the SD memory card and USB Mass Storage Class-compliant device forcibly.</td>
<td></td>
</tr>
<tr>
<td>USER²³</td>
<td>Displays contents specified by the user on the dot matrix LED. (Default)</td>
<td>Information display on the dot matrix LED</td>
</tr>
<tr>
<td>ERROR⁴</td>
<td>Displays an error code on the dot matrix LED.</td>
<td></td>
</tr>
<tr>
<td>CH1⁵</td>
<td>Displays IP address of the Ethernet port (CH1) on the dot matrix LED.</td>
<td></td>
</tr>
<tr>
<td>CH2⁵</td>
<td>Displays IP address of the Ethernet port (CH2) on the dot matrix LED.</td>
<td></td>
</tr>
</tbody>
</table>
*1 The LED display scrolls horizontally (right to left) to display the portion not appeared on dot matrix LED.
*2 The selected operation is registered in the behavior caused when holding the switch in the SELECT position, and can be performed even in the normal operation mode.
*3 The character string output with the C Controller module dedicated function (CCPU_SetDotMatrixLED) is displayed. In addition, when this operation is selected again after switched to other operation, the previously shown character string will be displayed.
*4 The latest error is displayed. ("—" is displayed when no error occurred.)
*5 When an IP address is not set, "—.—.—.—" is displayed.

Performing the 'notification/unmount' in the normal operation mode
The last selected operation (out of 'notification/unmount') in the operation selection mode is registered as the operation performable by holding the switch in the SELECT position. By holding the MODE/SELECT switch in the SELECT position, the registered operation can be performed even in the normal operation mode.

1. Hold the MODE/SELECT switch (1) in the SELECT position.
2. The operation selected in the operation selection mode is performed.

- By setting the MODE/SELECT switch to the SELECT position once during the normal operation, the operation that is currently selected is displayed on the dot matrix LED display.
- Even while performing the operation among the 'information display on the dot matrix LED', the operation among the 'notification/unmount' can also be performed.
6.6 Creating a Project

Create a project by starting CW Configurator.

[Project] → [New]

Creation procedure

1. Select the C Controller module to be used in the "New" screen, and click the [OK] button.

6.7 Connecting to Personal Computer

This section shows the procedure to have direct connection between a personal computer and a C Controller module.

Connection procedure

1. Connect a personal computer with a C Controller module using an Ethernet cable.

2. Select [Online] → [Current Connection Destination] from the menu of CW Configurator.

3. In the "Specify Connection Destination" screen, click the [CPU Module Direct Coupled Setting] button (1).

4. Select the connection method to the C Controller module, and click the [Yes] button.

5. Click the [Communication Test] button (2) in the "Specify Connection Destination" screen to check the connection to the C Controller module is available.
6.8 Setting Parameters

Set parameters for the system and modules.

**CW Configurator is connected to the actual system configuration**

Read the actual system configuration to the Module Configuration Diagram of CW Configurator to set parameters.

![Image of Module Configuration Diagram]

1. Open the Module Configuration Diagram, and select [Online] ⇒ [Read Module Configuration from PLC].

2. The system parameter has been set automatically, and the actual system configuration is displayed on the Module Configuration Diagram.

3. Double-click the CPU module, I/O module, and intelligent function module shown to display the parameter editor for the respective modules.

4. After setting the parameters, click the [Apply] button.

**Precautions**

RQ extension base unit, MELSEC-Q series extension base unit, or modules mounted on these extension base units cannot be read. For the modules unable to be read, create the module configuration by dragging each module from the Element Selection window and dropping it on the Module Configuration Diagram.
CW Configurator is not connected to the actual system configuration
Create the module configuration manually to set parameters.

1. Select a base unit to be used from the Element Selection window, and drag and drop it onto the Module Configuration Diagram.
2. Drag respective modules to be used and drop it on the base unit placed in the diagram.
3. Select [Edit] ⇒ [Parameter] ⇒ [Fix] from the menu.
4. Double click the module to display the parameter editor for the respective modules.
5. After setting the parameters, click the [Apply] button.

Parameter settings from the navigation window
Set the following parameters from the navigation window.

■ System parameter
To change the number of slots of a base unit or the number of occupied points for a module as well as to configure the multiple CPU setting or synchronization setting, the system parameter is set from the navigation window.

[Navigation window] ⇒ [Parameter] ⇒ [System Parameter]

■ Module parameter of CPU module
To use a built-in Ethernet function for CPU module, setting the module parameter for CPU module is required.

[Navigation window] ⇒ [Parameter] ⇒ [(CPU module)] ⇒ [Module Parameter]

■ Memory card parameter
To use any of the functions with SD memory card, setting the memory card parameter is required.

[Navigation window] ⇒ [Parameter] ⇒ [(CPU module)] ⇒ [Memory Card Parameter]

■ Multiple module parameters and module extended parameter
Some intelligent function modules may require parameter settings for multiple modules or module extended parameter setting.

[Navigation window] ⇒ [Parameter] ⇒ [Module Information] ⇒ [(each of Intelligent function module)] ⇒ [Module Extended Parameter] or [Module Parameter]

Settings with the module configuration diagram and settings by system parameter are used properly as follows depending on their usage.

• Module configuration diagram: Module-specific information such as the number of occupied points is used without changing.
• System parameter: The number of slots of a base unit or the number of occupied points for a module is changed.
6.9 Writing Parameters to C Controller Module

Write parameters to a C Controller module.

[Online] [Write to PLC]

Operating procedure

1. Select "System Parameter/CPU Parameter" and "Module Parameter".
2. Click the [Execute] button.
3. After writing to a C Controller module is completed, click the [Close] button.

The system parameter and CPU parameter are related to the operation of a C Controller module. The module parameter and module extended parameter are related to the use and operation of an I/O module or an intelligent function module.
6.10 Creating User Program

Create a user program by using VxWorks standard API functions and functions offered by a C Controller module in accordance with the specification of VxWorks.

For programming method of VxWorks standard API functions, refer to the manual for VxWorks of the following version.
- VxWorks Version 6.9

For details on the dedicated function library of the C Controller module, refer to the following manual.
- MELSEC iQ-R C Controller Module Programming Manual
- MELSEC iQ-R C Controller Module/C Intelligent Function Module Programming Manual (Data Analysis)

For details on sample programs, please consult your local Mitsubishi representative.

Programming procedure

The following shows the procedure for creating a user program.
For more details on project creation and programming method, refer to the following manual.
CW Workbench/CW-Sim Operating Manual

1. Install CW Workbench on a personal computer.
2. Start CW Workbench, and check that VxWorks image file version of the personal computer is the same as that of the C Controller module. (Page 53 Checking VxWorks Image File)
3. Create a project of the user program.
4. Configure the setting to use the dedicated function library.
5. Program for a user program.
6. Debug the user program.
7. Create a script file to start the user program. (Page 54 Creating Script File)
8. Register the created user program and the script file to the C Controller module. (Page 56 Registering User Program)

Considerations for creating a user program

The following shows the considerations when creating a user program.

- **Endian format (memory layout)**
  The endian format (memory layout) of a C Controller module is little endian. Compile a user program in the little endian format.

- **VxWorks real-time process (RTP)**
  A C Controller module does not support applications running in VxWorks real-time process. Create a user program as an application based on the VxWorks kernel.

- **Build property**
  Enter 
  
  
  Enter [-mlong-calls] to "Tool Flags", and then enter [-fsigned-char] to "Debug mode" and "Non Debugmode" to compile a user program.
  "Project Explorer" ⇒ right-click an arbitrary project ⇒ [Properties] ⇒ [Build Properties] ⇒ [Tools] from CW Workbench
**User program execution**
Execute a user program by starting a task from the script file. The system may malfunction if the user program is executed without the task being started.

**Startup of a task performing floating-point operations**
Always specify the VX_FP_TASK option for the third argument of taskSpawn when activating the following tasks.
- A task performing floating-point operations
- A task calling a function that returns floating-point value
- A task calling a function that takes floating-point value as an argument
- A task calling a data analysis function
- A task calling a statistical analysis function

Activating the above task without the VX_FP_TASK option specified may cause the operating system runaway. For information on specifying the VX_FP_TASK option in a script file, refer to the following section:
Page 54 Creating Script File
For more details on the VX_FP_TASK option, refer to the manual for VxWorks.

**Task execution in STOP or PAUSE status**
Even if the operating status of the C Controller module is STOP or PAUSE, the user program task does not stop. Use the C Controller module dedicated function (CCPU_GetCpuStatus) to split the user program processing according to the operating status of the Controller module.

**Priority of tasks to be executed**
Set the priority of a task to execute a user program as described below.
- When access is not made with FTP during user program execution, set the priority of the user program to 100 or more (100 to 255). Operating with the priority set to 0 to 99 may cause improper operation of the system.
- When the access is made with FTP while executing a user program, the actual FTP processing (task) of the C Controller module is performed at the priority of 200. Set the priority of the user program to 201 to 255. When setting the priority to 100 to 200, set a wait processing (such as taskDelay) in the user program to let the actual FTP processing operate.

**Communication with a target device via Ethernet**
To communicate with a target device via Ethernet, check the port number being used in the C Controller module in advance using the VxWorks standard "netstat" command *1. Do not use any port number that has already been used. Normal communication may not be performed if used.

*1 Execute the "netstat" command using the Telnet tool.

**When no response is returned from a function**
The response from a function may not be returned when an error occurs on a C Controller module. Design a user program to take into account the possibility of no response from the function. The error occurrence status can be checked using the C Controller module dedicated function (CCPU_GetErrInfo).

**Memory fragmentation**
Allocating and deallocating memory frequently may cause improper operation of the system due to memory fragmentation.

**Restrictions on MELSEC data link functions**
A path for a MELSEC data link function does not support to be shared among multiple tasks. Make sure to manage a path opening/closing for each task.

**When changing system clock rate**
- Use the C Controller module dedicated function (CCPU_SysClkRateSet) to change the system clock rate, and do not use the VxWorks standard API function (sysClkRateSet). Otherwise, the operation of VxWorks will be unstable.
**Settings of IP address**
Set the IP address of a C Controller module using an engineering tool. If it is set with a user program, the network may be no longer functional properly.

**Access to USB Mass Storage Class-compliant device**
To create a user program accessing a USB Mass Storage Class-compliant device, implement processing to check if accessing to the USB Mass Storage Class-compliant device is allowed and to retry. Although a USB Mass Storage Class-compliant device is automatically mounted when connected, it may take several minutes for the device to be accessible depending on its format type or capacity.

**Considerations for interrupt service routine**
Fully understand the specifications on VxWorks, operating system of a C Controller module, before creating a routine which will be executed in an interrupt service routine. Setting an inappropriate value to an argument of functions or executing a function other than C intelligent function module dedicated functions for ISR may cause the VxWorks runaway.
In the dedicated function library (excluding data analysis functions and statistical analysis functions) offered by a C Controller module, C Controller module dedicated functions for ISR can be used. To execute other dedicated functions synchronously with an interrupt, implement the notification processing in a user program and perform the processing in a task.

**Considerations for CW Workbench connection**
The following shows the considerations for CW Workbench connection.

**Error occurred during program download**
When a user program is specified and downloaded to a target (C Controller module) with CW Workbench, the system failure/stop (such as user watchdog timer error) may occur on a C Controller module during the download if the program size is too large.
Take either of the following corrective actions in the case of system failure/stop.
- Increase the value of the watchdog timer with CW Configurator
- Load the program and debug it in a C Controller module

**Interrupt processing delay**
During remote debugging with CW Workbench, a C Controller module may be in the interrupt-disabled state. Any processing called from an interrupt routine (such as C Controller dedicated functions for ISR) is not executed during that time. Interrupts that are expected to occur at the fixed interval such as periodic timer interrupt may be delayed.

**Restarting a C Controller module**
To restart a C Controller module, ensure that CW Workbench is disconnected. When the C Controller module is restarted with CW Workbench connected, CW Workbench automatically establishes the connection once the C Controller module has been started up. At that time, an error may occur since the system task which has been operating in the C Controller module is temporarily blocked.

**Message displayed on Host Shell**
Message(s) issued by VxWorks during Host Shell connection may be displayed. For details on messages of VxWorks, refer to the manual for VxWorks or the help of CW Workbench.
6.11 Checking VxWorks Image File

Before debugging a user program, check that the VxWorks image file version in the personal computer and a C Controller module is the same.

Specifying a different version of VxWorks image file prevents normal debugging.

Checking method

The checking methods for the VxWorks image file are shown below.

■ C Controller module

Check the firmware version with the diagnostic function of CW Configurator or the rating plate on the side of the C Controller module.

■ Personal computer

Check the file name of VxWorks image file specified with CW Workbench.

- R12CCPU-V_XX*1
  *1 XX: Firmware version

Version of VxWorks image files are not identical

If the version of VxWorks image file is different, acquire the new image file stored in the C Controller module.

1. Connect the C Controller module with the personal computer. (Page 25 WIRING)
2. Acquire the VxWorks image file *1 in the C Controller module using the FTP function.
   *1 The file is stored in the system memory (/SYSTEMROM/OS_IMAGEFILE).
3. Reconfigure the target server setting with CW Workbench.

Point

The default settings of the FTP function are as follows:
- Login name: target
- Password: password
6.12 Creating Script File

A script file, "STARTUP.CMD" is a file to describe the loading destination of a user program which starts at the time of a C Controller module startup and the starting order of tasks.

Considerations for creating a script file

- **Starting a user program**
  Describe a command so that a user program is executed by activating the task*1.
  
  *1 Priority: 100 to 255

- **Specifying VX_FP_TASK option**
  When specifying a VX_FP_TASK option for the third argument of taskSpawn, specify '0x1000000'.
  Starting with the VX_FP_TASK option specified for "funcA" function
  
  `taskSpawn("TaskA",100,0x1000000,20000,funcA,0,0,0,0,0,0,0)`

- **Script file storage location**
  A script file can be stored in the program memory and an SD memory card.
  Store a script file in the root directory.

- **A script file stored into both the program memory and an SD memory card**
  When a script file is stored in both memory, the script file in the SD memory card has priority, and the script file in the program memory is not executed.

  In the system which has been operated by a script file stored in the program memory, its processing can be switched for maintenance easily by installing an SD memory card in which a script file for maintenance work is stored.

Description of scripts

- **Description of commands**
  - Only one command can be described in one line.
  - Up to 12 arguments can be specified for one command.

- **Description of comment statements**
  - Describe "//" at the beginning of a line.
  - There is no limit on the number of characters in a statement.

- **Executing C++ functions**
  Describe the function declaration portion on C++ source code as follows.
  - extern "C" (Function declaration portion)

  Description of commands in a script file allows the following operations.
  - Copying a user program
  - Formatting the program memory

  Commands described in a script file are the same as contents described in a startup script file for VxWorks.
  For more details, refer to the manual for VxWorks.
Example of script file description

The following shows an example to load a user program in the program memory and SD memory card using a script file in the program memory.

Storage file

<table>
<thead>
<tr>
<th>Memory</th>
<th>File storage destination path</th>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program memory</td>
<td>/0</td>
<td>STARTUP.CMD</td>
<td>Script file to load a user program</td>
</tr>
<tr>
<td></td>
<td>/0/DirA</td>
<td>fileA.out</td>
<td>User program (&quot;funcA&quot; function has already been included.)</td>
</tr>
<tr>
<td>SD memory card</td>
<td>/2/DirB</td>
<td>fileB.out</td>
<td>User program (&quot;funcB&quot; function has already been included.)</td>
</tr>
</tbody>
</table>

Task contents

<table>
<thead>
<tr>
<th>Activation order</th>
<th>Task name</th>
<th>Priority</th>
<th>Stack size</th>
<th>Function name</th>
<th>Argument specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Default: tN (N=1, 2, ...)</td>
<td>Default: 100</td>
<td>Default: 20000 bytes</td>
<td>funcA</td>
<td>None</td>
</tr>
<tr>
<td>2</td>
<td>taskB</td>
<td>120</td>
<td>5000 bytes</td>
<td>funcB</td>
<td>Specified (First argument: 10)</td>
</tr>
</tbody>
</table>

Example of script file (STARTUP.CMD) description

```
ld(1,0,“/0/DirA/fileA.out”) /* (1) */
ld(1,0,“/2/DirB/fileB.out”) /* (2) */
sp(funcA,0,0,0,0,0,0,0,0,0) /* (3) */
taskSpawn("taskB",120,0,5000,funcB,10,0,0,0,0) /* (4) */
```

(1) Load the "fileA.out" file from "DirA" directory in the program memory.
(2) Load the "fileB.out" file from "DirB" directory in the SD memory card.
(3) Generate the "funcA" function under the default task name (t1). (The "funcA" function is already included in the fileA.out file.)
(4) Generate the "funcB" function under the task name, "taskB". (The "funcB" function is already included in the fileB.out file.)

Point

Up to 12 arguments can be specified for one command. Therefore, in the example of script file description above, up to seven arguments can be passed to the function entry specified for taskSpawn (example: funcB).

If eight or more arguments are specified, the task will not be activated.
6.13 Registering User Program

This section shows the procedure to register a user program.

1. Describe the loading destination of the user program which starts at the time of the C Controller module startup to the script file, "STARTUP.CMD".

2. Write the script file and user program file to the C Controller module.

3. Turn the power OFF and ON, or reset the C Controller module.

**Point**

- User program files can be stored in any memories that can store files.
- To register by overwriting, close the file before overwriting it. Overwriting with the file opened may fail.

---

**How to write**

The following methods are available to write a script file and a user program.

- Writing from a personal computer by using the FTP function
- Writing from an SD memory card by copying with a command in a script file

■ When writing files using the FTP function from a personal computer

The following shows the procedure to write files using the FTP function from a personal computer.

1. Create the following files.

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STARTUP.CMD</td>
<td>Script file to load a user program</td>
</tr>
<tr>
<td>file.out</td>
<td>User program</td>
</tr>
</tbody>
</table>

*1 Specify an arbitrary file name.

- STARTUP.CMD

```
ld(1,0,"/0/file.out") /*(1)*/
sp(func,0,0,0,0,0,0,0,0,0) /*/(2)*/
```

(1) Load the "file.out" file from root directory in the program memory.
(2) Generate the "func" function under the default task name (t1). (The "func" function is already included in the file.out file.)

2. Turn the power of the C Controller module ON.

3. Connect the C Controller module with the personal computer.

4. Access the C Controller module using the FTP function.

5. Write the script file and user program to the program memory.

6. Turn the power OFF and ON, or reset the C Controller module.

7. Check that the READY LED starts flashing. ("STARTUP.CMD" is executed.)

8. Check that the READY LED turns ON. ("file.out" is executed.)

**Point**

The default settings of the FTP function are as follows:

- Login name: target
- Password: password
When writing from an SD memory card by copying with a command in a script file

The following shows the procedure to copy files in an SD memory card by using a command in a script file.

Copy a file in the SD memory card in the following cases.

- When a personal computer and a C Controller module cannot be connected normally
- When writing a same user program in multiple C Controller modules

1. Create files.

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STARTUP.CMD</td>
<td>Script file to copy files to the program memory</td>
</tr>
<tr>
<td>STARTUP.ROM</td>
<td>Script file to load a user program</td>
</tr>
<tr>
<td>file.out</td>
<td>User program</td>
</tr>
</tbody>
</table>

*1 Use any file name other than "STARTUP.CMD".
*2 Use arbitrary file name.

- STARTUP.CMD
  
  ```
  copy("/2/file.out","/0/file.out") /*(1)*/
  copy("/2/STARTUP.ROM","/0/STARTUP.CMD") /*(2)*/
  ```

  (1) Copy the user program, "file.out" in the SD memory card to the program memory.
  (2) Rename the operational script file, "STARTUP.ROM" in the SD memory card to "STARTUP.CMD", and copy it to the program memory.

- STARTUP.ROM
  
  ```
  ld(1,0,"/0/file.out") /*(1)*/
  sp(func,0,0,0,0,0,0,0,0) /*(2)*/
  ```

  (1) Load the "file.out" file from root directory in the program memory.
  (2) Generate the "func" function under the default task name (t1). (The "func" function is already included in the file.out file.)

2. Write the created files to the SD memory card.

3. Insert the SD memory card to a C Controller module.

4. Turn the power OFF and ON, or reset the C Controller module.

5. Check that the READY LED starts flashing. ("STARTUP.CMD" is executed.)

6. Check that the READY LED turns ON. ("STARTUP.CMD" processing is completed.)

7. Turn the power of the C Controller module OFF, and remove the SD memory card.

8. Turn the power of the C Controller module ON.

9. Check that the READY LED starts flashing. (The file name is changed and "STARTUP.CMD" command which is copied to the program memory is executed.)

10. Check that the READY LED turns ON. ("file.out" is executed.)
6.14 Troubleshooting

This section explains the contents, causes, and corrective actions of various error which may occur during the system use. For module-specific troubleshooting, refer to the manual for respective modules.

In case of error occurrence, saving a user program or device status, etc. will be useful for clarifying the factors of the error.

Troubleshooting procedure

1. Check the LED on the power supply module.
   (MELSEC iQ-R C Controller Module User's Manual (Application))

2. Check the LED on the C Controller module.
   (MELSEC iQ-R C Controller Module User's Manual (Application))

3. Check the LED on each I/O module or intelligent function module. (User's manual for respective modules (Application))

4. Connect CW Configurator, and start the system monitor function. The module which causes error can be checked.
   (Page 59 System monitor)

5. Select the module causing the error, and start the Module Diagnostic function. The cause and corrective actions can be checked. (Page 60 Module diagnostics)

6. If the cause cannot be identified by the Module Diagnostic function, check the operation or error logs with CW Configurator to identify the causes. (Page 61 Event history)

7. If the cause still cannot be identified by the step 1 to 6, perform the troubleshooting by symptom. (User's manual for respective modules (Application))
Checking with CW Configurator

Use CW Configurator to check the errors occurred logs and to identify the cause of the error. Detailed information, cause of error, and corrective actions can be checked.

CW Configurator has the following functions which support troubleshooting.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System monitor</td>
<td>To display the module configuration, detailed information for each module, and an error status</td>
</tr>
<tr>
<td>Module diagnostics</td>
<td>To diagnose the operating status of each module (module information, existence of an error, or error logs, etc.)</td>
</tr>
<tr>
<td>Event history</td>
<td>To display the event information including error occurred on each module, performed operations, and error on the network</td>
</tr>
</tbody>
</table>

For more details on the functions of CW Configurator, refer to the following manual.

CW Configurator Operating Manual

System monitor

The System Monitor function displays the module configuration, detailed information of each module, and error status.

[Diagnostics] ⇨ [System Monitor]
Module diagnostics

The Module Diagnostic function diagnoses the operating status of each module (module status, existence of an error, or error logs, etc.).

It displays an error occurred, detailed status, causes, and corrective actions, so information necessary for troubleshooting can be checked. In addition, the error part on the parameter can be identified by selecting the error and click the [Error Jump] button.

In the [Module Information List] tab, the current LED information or switch information of the corresponding module can be checked.

[Diagnostics] ➜ [System Monitor] ➜ double-click an arbitrary module

■ Dot matrix LED information

"DotMatrixLED1" to "DotMatrixLED7" under "LED information" indicates the dot matrix LED display status.

The contents are displayed in hexadecimal notation, and the lower 20 bits of each data are valid.

<table>
<thead>
<tr>
<th>Item</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>DotMatrixLED1</td>
<td>Lighting bit data of the 1st row from the top</td>
</tr>
<tr>
<td>DotMatrixLED2</td>
<td>Lighting bit data of the 2nd row from the top</td>
</tr>
<tr>
<td>DotMatrixLED3</td>
<td>Lighting bit data of the 3rd row from the top</td>
</tr>
<tr>
<td>DotMatrixLED4</td>
<td>Lighting bit data of the 4th row from the top</td>
</tr>
<tr>
<td>DotMatrixLED5</td>
<td>Lighting bit data of the 5th row from the top</td>
</tr>
<tr>
<td>DotMatrixLED6</td>
<td>Lighting bit data of the 6th row from the top</td>
</tr>
<tr>
<td>DotMatrixLED7</td>
<td>Lighting bit data of the 7th row from the top</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dot matrix LED display</th>
<th>LED information</th>
<th>Lower 20 bits (Binary)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DotMatrixLED1</td>
<td>0010 0111 0001 1000 0100</td>
</tr>
<tr>
<td></td>
<td>DotMatrixLED2</td>
<td>0110 0100 1010 0100 1100</td>
</tr>
<tr>
<td></td>
<td>DotMatrixLED3</td>
<td>0010 0000 1000 0101 0100</td>
</tr>
<tr>
<td></td>
<td>DotMatrixLED4</td>
<td>0010 0001 0000 1001 0100</td>
</tr>
<tr>
<td></td>
<td>DotMatrixLED5</td>
<td>0010 0100 0010 0100 0100</td>
</tr>
<tr>
<td></td>
<td>DotMatrixLED6</td>
<td>0010 0111 1001 1000 0100</td>
</tr>
<tr>
<td></td>
<td>DotMatrixLED7</td>
<td>0010 0111 1001 1000 0100</td>
</tr>
</tbody>
</table>
**Event history**

The Event History function displays the event information including error occurred on each module, performed operations, and error on the network. Since the information collected before turning the power OFF or resetting can be saved, it is used to identify the cause of abnormalities from past operations or error occurrence tendency. The displayed information can be saved in CSV file format.

[Diagnostics] \(\Rightarrow\) [System Monitor] \(\Rightarrow\) [Event History]

---

**Point**

Use the event history function in the following cases.

- For checking error occurrence status for all modules, and clarifying the causes of malfunction which occurred on the facilities/equipment
- For checking when and from where a parameter of a user program has been changed
- For checking if any unauthorized access from a third party has been tried

For more details on the function or information collected with the event history function, refer to the following manual.

[Melsec iQ-R C Controller Module User's Manual (Application)]
## 7 MAINTENANCE AND INSPECTION

This chapter shows items that should be maintained or inspected daily or periodically to use a C Controller module properly and in optimal condition at all times.

### 7.1 Daily Inspection

This section shows items that should be inspected daily.

<table>
<thead>
<tr>
<th>Item</th>
<th>Inspection item</th>
<th>Inspection method</th>
<th>Acceptance criteria</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mounting status of a base unit</td>
<td>Looseness</td>
<td>Check that mounting screws are not loose and the cover is not dislocated.</td>
<td>The base unit is securely fixed.</td>
</tr>
<tr>
<td>2</td>
<td>Mounting status of a module</td>
<td>Looseness</td>
<td>Check that the module is mounted and the module fixing hook is fixed securely on the base unit.</td>
<td>The module is securely mounted.</td>
</tr>
<tr>
<td>3</td>
<td>Connection status</td>
<td>Terminal screw looseness</td>
<td>Check for the terminal screw looseness.</td>
<td>The terminal screws are not loose.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clearance between the solderless terminals</td>
<td>Check the clearance between the solderless terminals.</td>
<td>The proper clearance has been provided between the solderless terminals.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Connector looseness</td>
<td>Check for the cable connector looseness.</td>
<td>The cable connector is not loose.</td>
</tr>
<tr>
<td>4</td>
<td>LED status</td>
<td>POWER LED (Power supply module)</td>
<td>Check the lighting status.</td>
<td>The LED is ON. (Failure if it is OFF)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>READY LED</td>
<td>Check the lighting status in the BUS RUN state.</td>
<td>The LED is ON. (Failure if it is OFF)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ERROR LED</td>
<td>Check the lighting status.</td>
<td>The LED is OFF. (Failure if it is ON or flashing)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dot matrix LED</td>
<td>Check the lighting status.</td>
<td>The LED turns ON and OFF.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>I/O indicator LED (I/O module)</td>
<td>Check the lighting status.</td>
<td>I/O signal is ON: The LED is ON. I/O signal is OFF: The LED is OFF.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>User's manual (Application) for each module</td>
</tr>
</tbody>
</table>
### 7.2 Periodic Inspection

This section shows items that should be inspected once or twice every six months to a year. Also, check these items when the equipment has been relocated or modified, or the wiring layout has been changed.

<table>
<thead>
<tr>
<th>Item</th>
<th>Inspection item</th>
<th>Inspection method</th>
<th>Acceptance criteria</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ambient environment</td>
<td>Ambient temperature</td>
<td>Measure the temperature by using a thermometer.</td>
<td>0 to 55°C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ambient humidity</td>
<td>Measure the humidity by using a hygrometer.</td>
<td>5 to 95 %RH</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Atmosphere</td>
<td>Measure corrosive gases.</td>
<td>No corrosive gases.</td>
</tr>
<tr>
<td>2</td>
<td>Power supply voltage check</td>
<td>Measure a voltage between the terminals of 100/200 VAC and 24 VDC.</td>
<td>85 to 264 VAC</td>
<td>Change the power supply.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>15.6 to 31.2 VDC</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Mounting status</td>
<td>Looseness and backlash</td>
<td>Touch the module to check for the looseness and rattling.</td>
<td>The module must be mounted securely.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Attachment of dirt and foreign material</td>
<td>Check visually.</td>
<td>No dirt or foreign material is attached.</td>
</tr>
<tr>
<td>4</td>
<td>Connection status</td>
<td>Terminal screw looseness</td>
<td>Check for the terminal screw looseness.</td>
<td>The terminal screws are not loose.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clearance between the solderless terminals</td>
<td>Check the clearance between the solderless terminals.</td>
<td>The proper clearance has been provided between the solderless terminals.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Connector looseness</td>
<td>Check for the cable connector looseness.</td>
<td>The cable connector is not loose.</td>
</tr>
</tbody>
</table>
This chapter shows the operation example of a C controller module.

The operation example in this chapter explains the settings in Windows® 7.

### 8.1 System configuration example

The following system configuration is used in the operation example.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Base unit</td>
<td>R35B</td>
<td>A unit to mount a power supply module, a C Controller module, and I/O modules.</td>
</tr>
<tr>
<td>(2)</td>
<td>Power supply module</td>
<td>R62P</td>
<td>A module which supplies power to modules, such as a C Controller module and I/O modules.</td>
</tr>
<tr>
<td>(3)</td>
<td>C Controller module</td>
<td>R12CCPU-V</td>
<td>A module which unifies control process of a C Controller system.</td>
</tr>
<tr>
<td>(4)</td>
<td>Output module</td>
<td>RY40NT5P</td>
<td>--</td>
</tr>
<tr>
<td>(5)</td>
<td>Cable (Ethernet cable)</td>
<td>RY40NT5P</td>
<td>An Ethernet cable that meets 10BASE-T/100BASE-TX/1000BASE-T standards. A cable which connects a personal computer in which CW Configurator and CW Workbench are installed and a C Controller module.</td>
</tr>
</tbody>
</table>
8.2 Setting the Module

Initializing the C Controller module

A C Controller module is required to be initialized before the first operation. For the method for initializing a module, refer to the following section.

Setting parameters

Set parameters for the C Controller module.

Connecting the C Controller module to the personal computer

Connect the personal computer (1) to the CH1 on the C Controller module (2) using an Ethernet cable.

Precautions

The IP address of the C Controller module and that of the personal computer are required to be set in the same segment. In this operation example, the default IP address is set for the C Controller module (192.168.3.3); therefore, set ‘192.168.3.* (*: except for 0, 3, and 55)’ for the personal computer. Set the subnet mask for the personal computer to ‘255.255.255.0’.

For how to change an IP address, refer to the following manual.

Starting CW Configurator to create a project

Operating procedure

1. Select [Start] ⇒ [All Programs] ⇒ [MELSOFT] ⇒ [CW Configurator] ⇒ [CW Configurator].
2. Select [Project] ⇒ [New].
3. Check that “RCPU” and “R12CCPU-V” are selected, and click the [OK] button.
Establishing communication with the C Controller module

Operating procedure


2. Click the [CPU Module Direct Coupled Setting] button in the "Specify Connection Destination" screen.

3. Select "Ethernet", and click the [Yes] button.
4. Click the [Connection Test] button, and check that the message "Successfully connected with the R12CCPU-V." appears.
**Setting parameters**

Set parameters for the system and modules.

**Operating procedure**

1. Double-click "Module Configuration" in the "Navigation" window to open, and select [Online] ⇒ [Read Module Configuration from PLC].

2. When the following message appears, click the [Yes] button.

3. Click the [OK] button when the following message appears after reading is completed.
4. The system parameters are automatically set, and the actual system configuration is displayed in the "Module Configuration" window.
Writing parameters to the C Controller module

Write the parameters to the C Controller module using CW Configurator.

Operating procedure

1. Select [Online] ⇒ [Write to PLC].

2. Click the [Yes] button.

3. Check that the "Online Data Operation" screen appears.

5. Click the [Yes to all] button.

Writing the parameters starts.

6. Click the [Close] button when writing to the C Controller module is completed.
8.3 Programming

Create a program in which lamps connected to an output module and the dot matrix LED on the front of the C Controller module flash.

Program example and control description

When the C Controller module is set to RUN, the output lamps Y10 and Y11 alternately turn ON. Synchronizing with the output lamps, the dot matrix LED on the front of the C Controller module switches alternately between "00__" and "__00".

```c
/* Output control */
sRet = CCPU_Y_Out_WordEx(NORMAL_ACCESS, UNIT_XY, WORD, &usDataBuf, DUMMY);
if(sRet != 0){
printf("ERROR : CCPU_Y_Out_WordEx_1 [%d(%04hxH)]\n", sRet, sRet);
return;
}

/* Dot matrix LED control */
sRet = CCPU_SetDotMatrixLED(DISPMODE_ASCII, &pcdata[0]);
if(sRet != 0){
printf("ERROR : CCPU_SetDotMatrixLED_1 [%d(%04hxH)]\n", sRet, sRet);
return;
}
```
The following describes source codes.

```c
#include <vxworks.h>   /* VxWorks function header */
#include <taskLib.h>   /* VxWorks function header */
#include <stdio.h>  /* Standard function header */
#include <string.h>  /* Standard function header */
#include "CCPUFunc.h"  /* C Controller module dedicated function header */

#define UNIT_XY  0x0010  /* Start I/O number of the module */
#define RY_LED  0x5555  /* Initial output value of Y signals (even bit: on) */
#define LED_0   0x30  /* Initial output value on the dot matrix LED (LED1,2) */
#define LED_SPACE  0x20  /* Initial output value on the dot matrix LED (LED3,4) */

#define WORD    1 /* 1-word specification */
#define NORMAL_ACCESS  0 /* General access specification */
#define DUMMY   0 /* Dummy */
#define DISPMODE_ASCII 1 /* Dot matrix LED output mode */

void R12_SampleTask()
{
    short   sRet;   /* Return value of the C Controller module dedicated function */
    unsigned short  usDataBuf;   /* For accessing Y signals */
    unsigned short  usEmptyDataBuf; /* For resetting Y signals */
    char   pcdata[4];   /* Value on the dot matrix LED */
    short   i;    /* For loop */

    // Set the output value of Y signals (turn on the even bit).
    usDataBuf = RY_LED;

    // Set the output value of the dot matrix LED (LED1,2: on).
    pcdata[0] = LED_0;
    pcdata[1] = LED_0;
    pcdata[2] = LED_SPACE;
    pcdata[3] = LED_SPACE;

    // Perform an output control and dot matrix LED control in turns for 20 times.
    for(i = 0; i < 20; i++){
        /* Output control */
        sRet = CCPU_Y_Out_WordEx(NORMAL_ACCESS, UNIT_XY, WORD, &usDataBuf, DUMMY);
        if(sRet != 0){
            printf("ERROR : CCPU_Y_Out_WordEx_1 [%d(%04hxH)]\n", sRet, sRet);
            return;
        }
    }
}
```

/* Dot matrix LED control */
sRet = CCPU_SetDotMatrixLED(DISPMODE_ASCII, &pcdata[0]);
if(sRet != 0){
    printf("ERROR : CCPU_SetDotMatrixLED_1 [%d(%04hxH)]\n", sRet, sRet);
    return;
}

/* Invert the output value of Y signals (turn on the bits in order of odd bit -> even bit -> ...). */
usDataBuf = ~usDataBuf;

/* Switch the output of the dot matrix LED (LED1,2: on -> LED3,4: on). */
if(i/2 ==0){
    pcdata[0] = LED_SPACE;
    pcdata[1] = LED_SPACE;
    pcdata[2] = LED_0;
    pcdata[3] = LED_0;
}else{
    pcdata[0] = LED_0;
    pcdata[1] = LED_0;
    pcdata[2] = LED_SPACE;
    pcdata[3] = LED_SPACE;
}
/* Wait */
taskDelay(60);

/* Reset Y signals. */
usEmptyDataBuf = 0x00;
sRet = CCPU_Y_Out_WordEx(NORMAL_ACCESS, UNIT_XY, WORD,&usEmptyDataBuf, DUMMY);
if(sRet != 0){
    printf("ERROR : CCPU_Y_Out_WordEx_2 [%d(%04hxH)]\n", sRet, sRet);
    return;
}

/* Reset the dot matrix LED. */
pcdata[0] = LED_SPACE;
pcdata[1] = LED_SPACE;
pcdata[2] = LED_SPACE;
pcdata[3] = LED_SPACE;
sRet = CCPU_SetDotMatrixLED(DISPMODE_ASCII, &pcdata[0]);
if(sRet != 0){
    printf("ERROR : CCPU_SetDotMatrixLED_2 [%d(%04hxH)]\n", sRet, sRet);
    return;
}
Creating a project

Starting CW Workbench

Operating procedure

1. Select [Start] ⇒ [All Programs] ⇒ [Wind River] ⇒ [CW Workbench 3.3] ⇒ [CW Workbench 3.3].

2. After CW Workbench is started, enter the save destination folder for a project.
   In this procedure, enter ‘C:\WindRiver\workspace’.

3. Click the [OK] button.

The main window of CW Workbench appears.

- The default window sizes and icon positions on CW Workbench depend on a personal computer. If a window size differs from that shown in this operation example, adjust the size.
- To default an enlarged/deleted window, select [Window] ⇒ [New Window].
Creating a new project

Operating procedure

1. Select [File] ➔ [New] ➔ [Wind River Workbench Project].

2. Select "Wind River VxWorks 6.9", and click the [Next] button.

3. Select "Downloadable Kernel Module", and click the [Next] button.
4. Enter a project name, and click the [Finish] button.
(Project name: 'R12_SampleProject' in this chapter)
Setting properties of the project

Configure the settings to convert (build) the created project into a module that can be executed on the C Controller module.

Point

Build: An operation that compiles source codes according to a processor and links the code to the include file.

Setting a processor

Operating procedure

1. Select the created project in the "Project Explorer" window, and select [Project] ⇒ [Properties].

2. Select "Build Properties" from the tree to the left in the screen.

4. Select only the checkbox of "ARMARCH7gnu_SMP" in "Available and enabled build specs".
5. Select the checkbox of “Debug mode”.

5.

![Debug mode checkbox selected]

For the actual system operation, unselect the checkbox of “Debug mode”.

6. Select the [Tools] tab, enter “-mlong-calls” in the field next to the [Tool Flags] button.

6.

![Tool Flags field with -mlong-calls entered]
7. Enter "-fsigned-char" in the fields next to the [Debug mode] button and [Non Debug mode] button under "Debug mode flags".

Setting an include file

Operating procedure

1. Select the [Paths] tab, and click the [Add] button.

2. Click the [Browse] button.
3. Select the include folder for the C Controller module in the "Select directory" screen, and click the [OK] button. In this procedure, the include file is stored in "C:\MELSEC\R12CCPU-V".

4. Check that the selected folder is specified in the "Add include search path to selected build spec" screen, and click the [OK] button.

5. Check that the added include path is displayed in "Include paths", and click the [OK] button.

6. If the following message appears after clicking the [OK] button, click the [Yes] button.
7. Add the include file to the include folder added in step 1 to 5.
To acquire an include file stored in the C Controller module, start Explorer and enter the following address in the address bar.
ftp://192.168.3.3/SYSTEMROM/INCLUDE/

The "Log On As" screen appears.

8. Enter the following user name and password in the "Log On As" screen.
   • User name: target
   • Password: password

9. Click the [Log On] button.

10. Copy the header file to the include folder added in step 1 to 5.
Preparing a user program

Prepare a user program that controls the C Controller system.
A sample program for the quick start guide is used in this operation example.

For information on how to obtain sample programs for the quick start guide, please contact your local Mitsubishi Electric sales office or representative.

Adding a sample program

Operating procedure

1. Store a sample program immediately under the created project folder.
   "C:\WindRiver\workspace\R12_SampleProject"

2. Select and right-click the created project in the "Project Explorer" window, and select [Refresh].
3. The sample program stored in step 1 is added to the project.
Generating an execution module from the user program

Convert (build) the created program into a module that can be executed on the C Controller module.

Operating procedure

1. Select and right-click the created project in the "Project Explorer" window, and click [Rebuild Project].

2. If the following message appears after selecting [Rebuild Project], click the [Continue] button.

The project starts to be built. The progress is displayed in the "Build Console" window.

3. Check that "Build Finished..." is displayed in the "Build Console" window.

Point

If "Build Finished..." is not displayed and an error occurs, check the error and modify the program. After modifying the program, perform the operation again from 'Page 86 Generating an execution module from the user program'.

Operating procedure

1. Select and right-click the created project in the "Project Explorer" window, and click [Rebuild Project].

2. If the following message appears after selecting [Rebuild Project], click the [Continue] button.

The project starts to be built. The progress is displayed in the "Build Console" window.

3. Check that "Build Finished..." is displayed in the "Build Console" window.

Point

If "Build Finished..." is not displayed and an error occurs, check the error and modify the program. After modifying the program, perform the operation again from 'Page 86 Generating an execution module from the user program'.

Operating procedure

1. Select and right-click the created project in the "Project Explorer" window, and click [Rebuild Project].

2. If the following message appears after selecting [Rebuild Project], click the [Continue] button.

The project starts to be built. The progress is displayed in the "Build Console" window.

3. Check that "Build Finished..." is displayed in the "Build Console" window.

Point

If "Build Finished..." is not displayed and an error occurs, check the error and modify the program. After modifying the program, perform the operation again from 'Page 86 Generating an execution module from the user program'.
Connecting the C Controller module with CW Workbench

Connect the user Ethernet port CH1 of the C Controller module with CW Workbench to perform debugging in CW Workbench.

Operating procedure

1. To acquire a VxWorks image file from the C Controller module, start Explorer and enter the following address in the address bar.
ftp://192.168.3.3/SYSTEMROM/OS_IMAGEFILE/

The "Log On As" screen appears.

To communicate between the C Controller module and the personal computer, specify the same VxWorks image file for both.

2. Enter the following user name and password in the "Log On As" screen.
   • User name: target
   • Password: password

3. Click the [Log On] button.

4. Create "C:\MELSEC\R12CCPU-V\CCPUTool" folder, and copy the VxWorks image file stored in the C Controller module to the folder.
5. Click in the "Remote Systems" window.

The "New Connection" screen appears.


7. Click the [Next] button.

8. Set the following items in "Backend settings".
   • Processor : ARM9 (Click the [Select] button and select the processor.)
   • Backend: wdbrpc
   • IP Address: 192.168.3.3 (default)
   • Port: blank
9. Select "File" in "Kernel image".

10. Click the [Browse] button.

The "Open File" screen appears.

11. Select the VxWorks image file copied to the "C:\MELSEC\R12CPU-V\CCPUTool" folder in step 4, and click the [Open] button.

12. Click the [Finish] button.
13. The connection is completed when "Connected - Target server running" is displayed at the bottom of the "Remote Systems" window.

If "Connected - Target server running" is not displayed, check that the C Controller module is normally powered ON, and perform the operation again from 'Page 87 Connecting the C Controller module with CW Workbench'.
Debugging the user program
Check if the created program runs properly.

Downloading the user program on the C Controller module
To debug the user program, download the execution module on the memory in the C Controller module.
By downloading a user program, the program can be executed with no script file.

Point

Script file: A file to describe a loading location of a user program that starts at the start of a C Controller module and a startup order of the user program.

Operating procedure

1. Select and right-click the created module file "R12_SampleProject.out" in the "Project Explorer" window, and select [Download] ⇒ [VxWorks Kernel Task].

The "Download Configurations" screen appears.

2. Select only the checkbox of "VxWorks6x_192.168.3.3 (Wind River VxWorks 6.9)" in the [Launch Context] tab, and click the [Download] button.
The "Launch Configuration Selection" screen appears on and after the second operation of the step 2. Select "Launch the selected launch configuration", and click the [OK] button.

---

## Debugging the user program

### Operating procedure

1. Select the created project in the "Project Explorer" window, and click the [▼] button on the right side of on the toolbar.

2. Select [Debug Configurations].

The "Debug Configurations" screen appears.

3. Select the downloaded module "R12_SampleProject.out" under "VxWorks Kernel Task".
4. Select a target server indicating connection to the C Controller module.

5. Click the [Browse] button.

The "Entry Points" screen appears.

6. Select the function "R12_SampleTask" that starts debugging, and click the [OK] button.
7. Check that the function name selected in step 6 is set for "Entry Point", and click the [Debug] button.

8. Debugging starts. Program execution stops at the start of the function specified for "Entry Point".

9. Click in the "Debug" window to debug a program by one step.
10. Variable values can be checked and changed in the "Variables" window on the bottom right of the screen. Check that 'sRet', return value of the CCPU function, is '0' (normal value) in this step.
(a) Run the programs to the line indicated with the red arrow '→' by the step execution in step 9.
(b) Check that the value of sRet is '0' (normal value) in the [Variables] tab.

Repeat steps 9 and 10 to debug the whole created program.

**Point**

When the return value of the C Controller module dedicated function is other than '0', refer to the following manual and troubleshoot the symptom.

MELSEC iQ-R C Controller Module Programming Manual
**Debugging using breakpoint**
As well as debugging in units of one step described in step 9, debugging using a breakpoint is available.

**Operating procedure**

1. Double-click the left edge of the source file window and insert a breakpoint.

![Breakpoint Insertion](image1)

2. Click .

![Run to Breakpoint](image2)

The program runs to the position where the breakpoint is specified.
The descriptions of icons are as follows:

- \(\text{\textbullet\textcircled{1}}\): Step Into (Steps into the called function and stops at the first line of the function.)
- \(\text{\textbullet\textcircled{2}}\): Step Over (Executes the current line of the function and then stops at the next line of the function.)
- \(\text{\textbullet\textcircled{3}}\): Continues execution of the current function until it returns to its caller.
- \(\text{\textbullet\textcircled{4}}\): Executes a program.
- \(\text{\textbullet\textcircled{5}}\): Stops program execution.
- \(\text{\textbullet\textcircled{6}}\): Ends debugging.

3. Click \(\text{\textbullet\textcircled{6}}\) in the "Debug" window to end the debugging.

To start debugging again, click the \(\text{\textbullet\textcircled{6}}\) button on the right side of \(\text{\textbullet\textcircled{1}}\) on the toolbar, and select the created debug configuration at the top of the pop-up menu.

By the operations above, the steps 1 to 8 in 'Page 92 Debugging the user program' can be skipped.
Registering the execution module
Build the created program for operation, and store the program on the C Controller module.

Building the user program

Operating procedure

1. Select the created project in the "Project Explorer" window, and select [Project] ➔ [Properties].

2. Select "Build Properties" from the tree to the left in the screen, unselect the "Debug mode" checkbox, and click the [OK] button.

3. If the following message appears after clicking the [OK] button, click the [Yes] button.

4. Build the program by following the procedure in 'Page 86 Generating an execution module from the user program'.
Storing the user program

Operating procedure

1. Start Explorer, and enter the following address in the address bar.
ftp://192.168.3.3/0
After login to the C Controller module, the address is displayed as follows.

2. Copy the created user program "R12_SampleProject.out" to the program memory '0' in the C Controller module by a
drag and drop operation.
The user program created in this example is stored in the following directory:
C:\WindRiver\workspace\R12_SampleProject\ARMARCH7gnu_SMP\R12_SampleProject\Debug
Creating and storing a script file
Create a script file that automatically downloads the execution module at the start of the C Controller module.

Operating procedure

1. Open a text file and describe a script file that downloads a user program and generates a task, as shown below.

(1) The "R12_SampleProject.out" file is loaded from the program memory '0'.
(2) The "R12_SampleTask" function is generated under the default task name (t1).

2. Name the file as "STARTUP.CMD" and save the file.

3. Copy the created script file to the program memory in the C Controller module.

ftp://192.168.3.3/0

The script file has been created and stored.

Point

A user program and a script file can be stored on the SD memory card as well. When a script file is stored in both the program memory and the SD memory card, one in the SD memory card is started by priority.
### 8.4 Checking Operations

Run the program registered in the C Controller module to check its operations.

The status of the C Controller module can be changed by the RESET/STOP/RUN switch on the front of the module.

Change the status of the RESET/STOP/RUN switch as follows, depending on the purpose.

- **RUN**: State where output (Y) from a user program and writing to the buffer memory are permitted
- **STOP**: State where output (Y) from a user program and writing to the buffer memory are prohibited
- **RESET**: Resets the module.

- The C Controller module executes program operation regardless of the switch status (RUN/STOP).
- For details on the RUN/STOP/RESET switch, refer to the following section. (Page 43 RESET/STOP/RUN switch)

### Enabling outputs (Y) from the user program

**Operating procedure**

1. Set the RESET/STOP/RUN switch (1) on the front of the C Controller module to the RUN position.

2. When the BUS RUN LED (2) lights in green, the program is running normally.

---

8  OPERATION EXAMPLE
8.4 Checking Operations

---

101
Checking operations with the dot matrix LED and lamps

The dot matrix LED on the front of the C Controller module and output lamps operate as follows:

1. The display of the dot matrix LED on the front of the C Controller module switches alternately ten times.
2. Synchronizing with the dot matrix LED, the output lamps Y10 and Y11 alternately turn ON.
3. To check the operations again, reset the C Controller module.
Appendix 1  External Dimensions

The following figure shows the external dimensions of a C Controller module.

(Unit: mm)
This section explains how to use MELSEC-Q series modules.

Window change in CW Configurator

Setting items in Setting/monitoring tools for the C Controller module used for MELSEC-Q series are changed to the following windows in CW Configurator.

Parameter items

For parameter setting method on CW Configurator, refer to the following manual.

MELSEC iQ-R C Controller Module User's Manual (Application)

■ "Points", "Start XY", and "PLC Operation Mode at H/W Error" in "I/O assignment settings"

<table>
<thead>
<tr>
<th>Setting/monitoring tools for the C Controller module</th>
<th>CW Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Navigation window] ⇒ [CCPU Parameter] ⇒ [I/O assignment settings] tab</td>
<td>[Navigation window] ⇒ [Parameter] ⇒ [System Parameter] ⇒ [I/O Assignment Setting] tab</td>
</tr>
<tr>
<td>[Navigation window] ⇒ [CCPU Parameter] ⇒ [I/O assignment settings] tab ⇒ [Detailed Setting] button</td>
<td></td>
</tr>
</tbody>
</table>
“Switch Setting” and “Error Time Output Mode” in “I/O assignment setting”, and intelligent function module parameters

<table>
<thead>
<tr>
<th>Setting/monitoring tools for the C Controller module</th>
<th>CW Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Navigation window] ⇒ [CCPU Parameter] ⇒ [I/O assignment settings] tab ⇒ [Switch Setting]</td>
<td>[Navigation window] ⇒ [Parameter] ⇒ [Module Information] ⇒ [(module name)] ⇒ [Module Parameter]</td>
</tr>
<tr>
<td>[Navigation window] ⇒ [CCPU Parameter] ⇒ [I/O assignment settings] tab ⇒ [Detailed Setting] button</td>
<td></td>
</tr>
<tr>
<td>[Navigation window] ⇒ [Intelligent Function Module] ⇒ [(module name)]</td>
<td></td>
</tr>
</tbody>
</table>
## Interrupt pointer setting

In CW Configurator, the setting for interrupt pointer is changed as follows.

- Setting the SI No. for an interrupt module is not required.
- "Interrupt pointer" of an interrupt module must be sequential numbers. (Set I51 to No.2 and I52 to No.3 when No.1 is set to I50, for example.)

### Setting/monitoring tools for the C Controller module

<table>
<thead>
<tr>
<th>Setting/monitoring tools for the C Controller module</th>
<th>CW Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation window ⇒ Parameter ⇒ [System settings] ⇒ Intelligent Function Module Setting ⇒ [Interrupt event settings] button</td>
<td>Navigation window ⇒ Parameter ⇒ [Module Information] ⇒ [module name] ⇒ [Module Parameter]</td>
</tr>
</tbody>
</table>

### Intelligent function module tool

"Intelligent Function Module Tool" is changed to the window shown below.

### Setting/monitoring tools for the C Controller module

|------------------------------------------------------------------|-----------------------------------------------------------------|

![Diagram of Intelligent Function Module Interrupt Event Setting](image)

![Diagram of Module Tool List](image)
Setting procedure

The setting procedure for a MELSEC-Q series module in CW Configurator is shown below.

1. Create a module configuration in accordance with the actual configuration by dragging each MELSEC-Q series module from the Element Selection window and dropping it onto the Module Configuration Diagram.

2. Set the parameters of each module.

• When CW Configurator can be connected to the actual system configuration, the configuration can be read by selecting [Online] ⇒ [Read Module Configuration from PLC]. For modules of which configuration cannot be read, drag each module from the Element Selection window and drop it on the Module Configuration Diagram.

• To change "Points", "Start XY", "Control PLC Settings", or "CPU Module Operation Setting at Error Detected", set the parameters in "System Parameter"
Considerations

The modules requiring particular attentions are shown below.
For details, refer to the manual for the module used.

I/O module

■ High-speed input module
  • When the module is used as a high-speed input module, select the following model in accordance with the ON/OFF of a noise filter. The module operates with the default setting when the ON/OFF of the noise filter does not correspond to the ON/OFF of the model.
  • When the module is used as an interrupt module, select "QI60". The module operates with the default setting when it is used with the noise filter set to OFF.
  • When using one or more modules as interrupt modules, set the number of modules to be used in "I/O Assignment Setting" of the "System Parameter" screen.

<table>
<thead>
<tr>
<th>Module name</th>
<th>Model name displayed on CW Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Noise filter: ON</td>
</tr>
<tr>
<td>QX40H</td>
<td>QX40H (NoiseF_ON)</td>
</tr>
<tr>
<td>QX70H</td>
<td>QX70H (NoiseF_ON)</td>
</tr>
<tr>
<td>QX80H</td>
<td>QX80H (NoiseF_ON)</td>
</tr>
<tr>
<td>QX90H</td>
<td>QX90H (NoiseF_ON)</td>
</tr>
<tr>
<td></td>
<td>Noise filter: OFF</td>
</tr>
<tr>
<td>QX40H</td>
<td>QX40H (NoiseF_OFF)</td>
</tr>
<tr>
<td>QX70H</td>
<td>QX70H (NoiseF_OFF)</td>
</tr>
<tr>
<td>QX80H</td>
<td>QX80H (NoiseF_OFF)</td>
</tr>
<tr>
<td>QX90H</td>
<td>QX90H (NoiseF_OFF)</td>
</tr>
</tbody>
</table>

■ Interrupt module
When using one or more modules, set the number of modules to be used in "I/O Assignment Setting" of the "System Parameter" screen.

High-speed counter module and pulse input module
Check the latest error code with the System Monitor function since error codes for QD63P6 and QD60P8-G cannot be checked with the Module Diagnostic function. When more than one error occurred, refer to the buffer memory.

Positioning module
• Set parameters in a user program because the positioning data parameter cannot be written to the module.
• Check the latest error code with the System Monitor function since error codes for QD70P4, QD70P8, QD70D4, and QD70D8 cannot be checked with the Module Diagnostic function. When more than one error occurred, refer to the buffer memory (error codes for each axis).

Loop control module
Check the latest error code with the System Monitor function since error codes for the Q62HLC cannot be checked with the Module Diagnostic function. When more than one error occurred, refer to the buffer memory.
**FL-net interface module**

- Select the following module name displayed on the Module Configuration Diagram.

<table>
<thead>
<tr>
<th>Module name</th>
<th>Model name displayed on CW Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td>QJ71FL71</td>
<td>QJ71FL71(-T,-B5)(-F01)</td>
</tr>
<tr>
<td>QJ71FL71-F01</td>
<td></td>
</tr>
<tr>
<td>QJ71FL71-B5</td>
<td></td>
</tr>
<tr>
<td>QJ71FL71-B5-F01</td>
<td></td>
</tr>
<tr>
<td>QJ71FL71-T</td>
<td></td>
</tr>
<tr>
<td>QJ71FL71-T-F01</td>
<td></td>
</tr>
<tr>
<td>QJ71FL71-B2</td>
<td></td>
</tr>
<tr>
<td>QJ71FL71-B2-F01</td>
<td></td>
</tr>
</tbody>
</table>

- Select “Online” for “Operation Mode Setting” under “Switch Setting” in the “Module Parameter” screen.
- The size setting of area 1 for the cyclic data set in bit units in Setting/monitoring tools for the C Controller module changes to the setting in word units in CW Configurator.

**MODBUS interface module and MODBUS/TCP interface module**

- Before setting “Start MODBUS Device No.” of “MODBUS Device Assignment Parameter” in the “Module Parameter” screen, check the setting range in the manual in advance.
- For “Basic parameter starting method” and “MODBUS device assignment parameter starting method” of “Switch setting” in “Basic setting”, only “Start with the user-set parameters” can be selected. Write a program to set the automatic communication parameters as well as module parameters to which only “Switch Setting” is set in order to start with the default assignment parameters.

**AnyWireASLINK master module and AnyWire DB A20 master module**

When AnyWire DB A20 master module is used, select the following model displayed on the Module Configuration Diagram.

<table>
<thead>
<tr>
<th>Module name</th>
<th>Model name displayed on CW Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td>QJ51AW12D2</td>
<td>MELSEC_Partner</td>
</tr>
</tbody>
</table>

**Q series large type extension base unit (AnS series size)**

Select the module which can be mounted on the actual each extension base unit on the Module Configuration Diagram. When a Q series large type blank cover is used, select the module mounted on the Q series large type blank cover.
Appendix 3 Handling of Batteries

The battery used for C Controller modules is shown below.

<table>
<thead>
<tr>
<th>Supplied status</th>
<th>Classification for transportation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lithium battery built into the device</td>
<td>Non-hazardous material</td>
</tr>
</tbody>
</table>

Precautions

The battery replacement shall be charged. Please consult your local Mitsubishi representative.

Transport guidelines

When transporting lithium-containing batteries, they should be handled in accordance with the transportation regulations. Products are packed in compliance with the transportation regulations prior to shipment. When repacking any of the unpacked products for transportation, make sure to observe the IATA Dangerous Goods Regulations, IMDG (International Maritime Dangerous Goods) Code, and other local transportation regulations. For details, please consult the shipping carrier used.

Handling of batteries and devices with built-in batteries in EU member states

For details on handling of batteries in EU member states, refer to the following manual.

MELSEC iQ-R Module Configuration Manual

Disposal of a battery

A C Controller module has a built-in lithium battery (secondary battery). Prior to disposing of a C Controller module, follow the procedure below to dispose of the built-in battery.

1. Lift the ( ) portion on the side of the C Controller module, and remove the front cover.

2. Remove the printed circuit board from the case.
3. Remove five board fixing screws (M2) from the board.
4. Detach the printed circuit board from one another.

5. Cut off the (lead) portion of the battery, which is attached on the surface of the printed circuit board with RS-232 connector, using a tool such as nippers, and remove the battery.

6. Dispose of the battery in accordance with the disposal regulations of local governments.
Appendix 4  Enabling Parameters

To enable some parameters of intelligent function modules, an initialization instruction (turn the power of a specific device OFF and ON, and OFF again) is required for the module every time a C Controller module*1 starts.

*1 For a C Controller module with the firmware version ‘06’ or later, the parameters are enabled automatically.

For details on intelligent function modules, refer to the manual of each module.

Methods for enabling parameters

The following two methods are available for enabling parameters (turn the power of a device OFF and ON, and OFF again).

• Describe the processing to turn the power of a device OFF and ON, and OFF again in a user program, and write it to a C Controller module.

• Describe the processing to turn the power of a device OFF and ON, and OFF again in a script file (STARTUP.CMD), and write it to a C Controller module.

Example of script file (STARTUP.CMD) description

When turning OFF and ON, and OFF again the device (Y9) of the module whose start XY is 00C0

CCPU_Y_Out_BitEx(0,0xC9,0) /*(1)/
CCPU_Y_Out_BitEx(0,0xC9,1) /*(2)/
CCPU_Y_Out_BitEx(0,0xC9,0) /*(3)/

(1) Turns the device (Y9) of the module OFF.
(2) Turns the device (Y9) of the module ON.
(3) Turns the device (Y9) of the module OFF.

Corresponding device list

The following tables show the devices corresponding to an initialization instruction to an intelligent function module.

MELSEC iQ-R series

<table>
<thead>
<tr>
<th>Product name</th>
<th>Model name</th>
<th>Device</th>
<th>Signal name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog-digital converter module</td>
<td>R60AD4</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td></td>
<td>R60ADi8</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>R60ADV8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channel isolated analog-digital converter module</td>
<td>R60ADB8-G</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Digital-analog converter module</td>
<td>R60DA4</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td></td>
<td>R60DAi8</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>R60DAV8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channel isolated digital-analog converter module</td>
<td>R60DAB8-G</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td></td>
<td>R60DAB16-G</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channel isolated RTD input module</td>
<td>R60RDB8-G</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Channel isolated thermocouple input module</td>
<td>R60TDB8-G</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Product name</td>
<td>Model name</td>
<td>Device</td>
<td>Signal name</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>-----------------------------</td>
<td>--------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>Analog-digital converter module</td>
<td>Q64AD</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Channel isolated high resolution analog-digital</td>
<td>Q64AD-GH</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>converter module</td>
<td>Q62AD-DGH</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Channel isolated analog-digital converter module</td>
<td>Q68AD-G</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>(with signal conditioning function)</td>
<td>Q66AD-DG</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>High speed analog-digital converter module</td>
<td>Q64ADH</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Digital-analog converter module</td>
<td>Q62DAN</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Channel isolated digital-analog converter module</td>
<td>Q62DA-FG</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>High speed digital-analog converter module</td>
<td>Q64DAH</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Analog input/output module</td>
<td>Q64AD2DA</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Load cell input module</td>
<td>Q61LD</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Current transformer input module</td>
<td>Q68CT</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>RTD input module</td>
<td>Q64RD</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Channel isolated RTD input module</td>
<td>Q68RD3-G</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Thermocouple input module</td>
<td>Q64TD</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Channel isolated thermocouple/micro voltage</td>
<td>Q64TDV-GH</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>input module</td>
<td>Q68TD-G-H01</td>
<td>Y9</td>
<td>Operating condition setting request</td>
</tr>
<tr>
<td>Channel isolated thermocouple input module</td>
<td>Q64TCTTN</td>
<td>YB</td>
<td>Setting change instruction</td>
</tr>
<tr>
<td>Temperature control module</td>
<td>Q64TCTTBWN</td>
<td>YB</td>
<td>Setting change instruction</td>
</tr>
</tbody>
</table>
# INDEX

## B
- BUS RUN LED ........................................... 16

## C
- CARD RDY LED ........................................ 16
- Connecting and disconnecting USB Mass Storage Class-compliant Device ................. 42

## D
- Default IP setting .................................... 35
- Dot matrix LED ........................................ 16,36

## E
- Endian format ......................................... 18,50
- ERROR LED ............................................ 16
- Ethernet cable ....................................... 25
- Ethernet port .......................................... 16,18
- External dimensions ................................. 18

## H
- Hardware diagnostics ................................. 32,36,37
- HMI (GOT) .............................................. 29

## I
- Initialization ......................................... 34
- Inserting/removing an SD memory card .......... 41
- IP address ............................................. 26

## M
- MODE/SELECT switch ................................ 16
- Module initialization setting ....................... 35

## N
- Number of occupied I/O points .................... 18

## O
- Operating status ...................................... 43
- Operating system .................................... 18
- Operation selection mode ........................... 44

## P
- Product information marking ....................... 16

## R
- READY LED ........................................... 16
- RESET/STOP/SELECT switch ....................... 16
- RS SD/RD LED ......................................... 16
- RS-232 connector ..................................... 16,18,27

## S
- SD memory card ....................................... 16,24
- SD memory card slot ................................ 17,18
- SD/RD LED ............................................ 16
- Security password .................................... 35
- SPEED LED ............................................ 16

## U
- USB cable .............................................. 28
- USB connector ........................................ 16,18
- USB Mass Storage Class-compliant device ....... 16
- USB RDY LED ........................................ 16
- USER LED ............................................. 16
# REVISIONS

*The manual number is given on the bottom left of the back cover.

<table>
<thead>
<tr>
<th>Revision date</th>
<th>*Manual number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>February 2015</td>
<td>SH(NA)-081367ENG-A</td>
<td>First edition</td>
</tr>
<tr>
<td>April 2015</td>
<td>SH(NA)-081367ENG-B</td>
<td>Added or modified parts Section 3.2, Section 3.5</td>
</tr>
<tr>
<td>May 2015</td>
<td>SH(NA)-081367ENG-C</td>
<td>Added or modified parts COMPLIANCE WITH EMC AND LOW VOLTAGE DIRECTIVES, TERMS, Chapter 1, Chapter 2, Section 3.2, Section 3.3, Section 4.3, Section 6.4, Section 6.5, Section 6.10</td>
</tr>
<tr>
<td>July 2015</td>
<td>SH(NA)-081367ENG-D</td>
<td>Added or modified parts Section 3.5</td>
</tr>
<tr>
<td>October 2015</td>
<td>SH(NA)-081367ENG-E</td>
<td>Added or modified parts Section 3.2, Section 3.5, Section 4.3, Chapter 5, Section 6.4</td>
</tr>
<tr>
<td>April 2016</td>
<td>SH(NA)-081367ENG-F</td>
<td>Added or modified parts Section 3.5, Appendix 4</td>
</tr>
<tr>
<td>September 2016</td>
<td>SH(NA)-081367ENG-G</td>
<td>Added or modified parts INTRODUCTION, RELEVANT MANUALS, TERMS, Chapter 1, Chapter 2, Section 3.1, Section 3.5, Section 4.3, Section 6.2, Section 6.10, Section 6.11, Section 6.12, Section 6.13</td>
</tr>
<tr>
<td>April 2017</td>
<td>SH(NA)-081367ENG-H</td>
<td>Added or modified parts SAFETY PRECAUTIONS, RELEVANT MANUALS, TERMS, Chapter 5, Section 6.10</td>
</tr>
<tr>
<td>October 2017</td>
<td>SH(NA)-081367ENG-I</td>
<td>Added or modified parts Section 3.2, Chapter 5</td>
</tr>
<tr>
<td>December 2017</td>
<td>SH(NA)-081367ENG-J</td>
<td>Added or modified parts TERMS, Chapter 5, Section 6.10</td>
</tr>
<tr>
<td>December 2018</td>
<td>SH(NA)-081367ENG-K</td>
<td>Added or modified parts Chapter 8</td>
</tr>
<tr>
<td>July 2020</td>
<td>SH(NA)-081367ENG-L</td>
<td>Added or modified parts SAFETY PRECAUTIONS, CONDITIONS OF USE FOR THE PRODUCT</td>
</tr>
<tr>
<td>May 2021</td>
<td>SH(NA)-081367ENG-M</td>
<td>Added or modified parts TERMS, Chapter 2, Section 2.1, Chapter 5</td>
</tr>
<tr>
<td>October 2021</td>
<td>SH(NA)-081367ENG-N</td>
<td>Added or modified parts SAFETY PRECAUTIONS, COMPLIANCE WITH EMC AND LOW VOLTAGE DIRECTIVES</td>
</tr>
</tbody>
</table>

Japanese manual number: SH-081366-N

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 2015 MITSUBISHI ELECTRIC CORPORATION
WARRANTY

Please confirm the following product warranty details before using this product.

1. Gratis Warranty Term and Gratis Warranty Range
   If any faults or defects (hereinafter “Failure”) found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty term, the product shall be repaired at no cost via the sales representative or Mitsubishi Service Company.

   However, if repairs are required onsite at domestic or overseas location, expenses to send an engineer will be solely at the customer's discretion. Mitsubishi shall not be held responsible for any re-commissioning, maintenance, or testing on-site that involves replacement of the failed module.

   [Gratis Warranty Term]
   The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated place. Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

   [Gratis Warranty Range]
   (1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.

   (2) Even within the gratis warranty term, repairs shall be charged for in the following cases.

   1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's hardware or software design.

   2. Failure caused by unapproved modifications, etc., to the product by the user.

   3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary by industry standards, had been provided.

   4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the instruction manual had been correctly serviced or replaced.

   5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as earthquakes, lightning, wind and water damage.

   6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.

   7. Any other failure found not to be the responsibility of Mitsubishi or that admitted not to be so by the user.

2. Onerous repair term after discontinuation of production
   (1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued.

   Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.

   (2) Product supply (including repair parts) is not available after production is discontinued.

3. Overseas service
   Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA Center may differ.

4. Exclusion of loss in opportunity and secondary loss from warranty liability
   Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to:

   (1) Damages caused by any cause found not to be the responsibility of Mitsubishi.

   (2) Loss in opportunity, lost profits incurred to the user by Failures of Mitsubishi products.

   (3) Special damages and secondary damages whether foreseeable or not, compensation for accidents, and compensation for damages to products other than Mitsubishi products.

   (4) Replacement by the user, maintenance of on-site equipment, start-up test run and other tasks.

5. Changes in product specifications
   The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.
TRADEMARKS

Arm is a registered trademark of Arm Limited (or its subsidiaries) in the US and/or elsewhere.
VxWorks and Wind River are either registered trademarks or trademarks of Wind River Systems, Inc.
Windows is either a registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
The company names, system names and product names mentioned in this manual are either registered trademarks or trademarks of their respective companies.
In some cases, trademark symbols such as ″®″ or ″™″ are not specified in this manual.
Specifications subject to change without notice.